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Preface
Manual Information

Purpose This manual details the features, installation, operation, maintenance, and specifications for
the X50 Up/Cross/Downconverter.

Audience This manual is written for engineers, technicians, and operators responsible for the
installation, setup, and/or operation of X50 Up/Cross/Downconverter.

Revision
History Table P-1    Document Revision History

Edition Date Revision History

A November 2009 Initial Release

B December 2009 New specifications added

C June 2010 Information about phasing, Dolby E® alignment, 
new conversion standards, and logo generator

D September 2012 New or revised information of the following: 
Advanced Audio Processing, GPI specifications, 
control interface, data passing, power save 
mode, parameter control scripts, logo storage, 
servicing instructions, and 3G specifications

E January 2013 Addition of new SFP options

4.0 August 2015 Updates to button controls, auto routing, system 
presets, failsafe procedure, composite video 
output, logo generator, GPI, control script, 
analog audio specs, servicing

4.1 May 2019 Addition of WPF client application for remote 
control of device 
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Writing
Conventions

To enhance your understanding, the authors of this manual have adhered to the following 
text conventions:

Obtaining
Documents

Product support documents can be viewed or downloaded from our website. Alternatively, 
contact your Customer Service representative to request a document.

Unpacking/Shipping Information

Unpacking a
Product

This product was carefully inspected, tested, and calibrated before shipment to ensure years 
of stable and trouble-free service. 

1 Check equipment for any visible damage that may have occurred during transit. 

2 Confirm that you have received all items listed on the packing list. 

3 Contact your dealer if any item on the packing list is missing.

4 Contact the carrier if any item is damaged.

5 Remove all packaging material from the product and its associated components before you 
install the unit.

Keep at least one set of original packaging, in the event that you need to return a product 
for servicing. 

Table P-2    Writing Conventions

Term or Convention Description

Bold Indicates dialog boxes, property sheets, fields, 
buttons, check boxes, list boxes, combo boxes, 
menus, submenus, windows, lists, and selection 
names

Italics Indicates E-mail addresses, the names of books or 
publications, and the first instances of new terms 
and specialized words that need emphasis

CAPS Indicates a specific key on the keyboard, such as 
ENTER, TAB, CTRL, ALT, or DELETE

Code Indicates variables or command-line entries, such as 
a DOS entry or something you type into a field

> Indicates the direction of navigation through a 
hierarchy of menus and windows

hyperlink Indicates a jump to another location within the 
electronic document or elsewhere

Internet address Indicates a jump to a website or URL

Note: Indicates important information that helps to avoid 
and troubleshoot problems
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Product
Servicing

Except for firmware upgrades and jumper selections, the X50 is not designed for field 
servicing. Return the X50 unit to the Harris Customer Service Center for all hardware 
upgrades, modifications, or repairs.

Returning a
Product

In the unlikely event that your product fails to operate properly, contact Customer Service to 
obtain a Return Authorization (RA) number, and then send the unit back for servicing. 

If the original package is not available, you can supply your own packaging as long as it 
meets the following criteria:

 The packaging must be able to withstand the product’s weight.

 The product must be held rigid within the packaging.

 There must be at least 2 in. (5 cm) of space between the product and the container.

 The corners of the product must be protected.

Ship products back to us for servicing prepaid and, if possible, in the original packaging 
material. If the product is still within the warranty period, we will return the product prepaid 
after servicing.

Restriction on Hazardous Substances (RoHS) Directive
Directive 2002/95/EC—commonly known as the European Union (EU) Restriction on 
Hazardous Substances (RoHS)—sets limits on the use of certain substances found in 
electrical and electronic equipment. The intent of this legislation is to reduce the amount of 
hazardous chemicals that may leach out of landfill sites or otherwise contaminate the 
environment during end-of-life recycling. The Directive, which took effect on July 1, 2006, 
refers to the following hazardous substances: 

 Lead (Pb)

 Mercury (Hg)

 Cadmium (Cd)

 Hexavalent Chromium (Cr-V1)

 Polybrominated Biphenyls (PBB)

 Polybrominated Diphenyl Ethers (PBDE)

In accordance with this EU Directive, products sold in the European Union will be fully 
RoHS-compliant and “lead-free.” Spare parts supplied for the repair and upgrade of 
equipment sold before July 1, 2006 are exempt from the legislation. Equipment that 
complies with the EU directive will be marked with a RoHS-compliant symbol, as shown in 
Figure P-1.

Figure P-1  RoHS Compliance Symbol
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Waste from Electrical and Electronic Equipment 
(WEEE) Directive

The European Union (EU) Directive 2002/96/EC on Waste from Electrical and Electronic 
Equipment (WEEE) deals with the collection, treatment, recovery, and recycling of electrical 
and electronic waste products. The objective of the WEEE Directive is to assign the 
responsibility for the disposal of associated hazardous waste to either the producers or users 
of these products. As of August 13, 2005, producers or users are required to recycle 
electrical and electronic equipment at end of its useful life, and must not dispose of the 
equipment in landfills or by using other unapproved methods. (Some EU member states 
may have different deadlines.)

In accordance with this EU Directive, companies selling electric or electronic devices in the 
EU will affix labels indicating that such products must be properly recycled. Contact your 
local Sales representative for information on returning these products for recycling. 
Equipment that complies with the EU directive will be marked with a WEEE-compliant 
symbol, as shown in Figure P-2.

Figure P-2  WEEE Compliance Symbol

Safety Carefully review all safety precautions to avoid injury and prevent damage to this product or 
any products connected to it. If this product is rack-mountable, it should be mounted in an 
appropriate rack using the rack-mounting positions and rear support guides provided. To 
protect a frame from circuit overloading, connect each frame to a separate electrical circuit. 
If this product relies on forced air cooling, all obstructions to the air flow should be removed 
prior to mounting the frame in the rack. 

If this product has a provision for external earth grounding, ground the frame to the earth 
using the protective earth ground on the rear panel.

IMPORTANT! Only qualified personnel should perform service procedures. 

Always disconnect the power supply before removing the lid.
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Safety Terms and Symbols in this Manual

WARNING

Statements identifying conditions or practices that may result in personal injury or loss of 
life. High voltage is present.

CAUTION

Statements identifying conditions or practices that can result in damage to the equipment 
or other property.
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1 Introduction
Product 
Features

The X50 is a standalone up/down/cross converter in a 1-RU format. The X50 can provide 
broadcast quality multi-standard conversion along with support for aspect ratio change and 
AFD processing, closed captioning processing, video processing amplifier and video frame 
synchronization and delay, with built-in color correction. Audio processing capabilities 
include handling of 16 channels of embedded audio and 8 channels of discrete audio via 
AES or analog interfaces, with audio synchronization and delay for audio-to-video tracking.

Full handling of the embedded audio metadata is provided, with the ability to de-embed and 
re-embed metadata from external sources. An optional fiber optic sub-module (SFP) 
complements the SDI electrical inputs and outputs. 

Inputs  Two auto-sensing SD/HD/3G SDI inputs and one SD/HD/3G SDI fiber input with 
embedded audio, VANC data (WSS/VI/AFD, audio metadata and closed captioning/
teletext data)

 One SD/HD component YPrPb input

 One SD composite input

 One S-Video input

 Error monitoring (EDH, CRC) on each SDI input

 Genlock input with loopback: analog composite with support for tri- and bi-level sync 

 DARS input, unbalanced

 Four AES inputs, unbalanced

 Eight-channel analog audio inputs, balanced

 RS-422 serial port for external metadata

 Four GPI inputs, TTL

Outputs  Two SD/HD/3G SDI outputs and one SD/HD/3G SDI fiber output carrying the converted 
program signal with embedded audio, VANC data (WSS/VI/AFD, audio metadata and 
closed captioning/teletext data)

 One SD/HD component YPrPb/RGB output

 One SD composite output

 One S-Video output

 One HDMI output (audio and video streams)

 User-selectable input and output video standard/formats

 Four AES outputs, unbalanced
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 Eight-channel analog audio outputs, balanced

 RS-422 serial port for external metadata

 Four GPIO outputs, TTL

Video
Processing

 Dual-output processor supporting simultaneous down- and cross conversion; 
simultaneous up- and ARC conversion

 Advanced 10-bit image processor

 12-bit adaptive 3D comb filter color decoder

 Motion adaptive de-interlacing for exceptional vertical resolution

 Color space conversion between SD (601) and HD (709)

 User-configurable picture-resizing aspect ratio conversion (H/V size, H/V position and 
cropping)

 Fixed preset aspect ratios that include 16:9 anamorphic, 16:9 middle cut, 14:9, 4:3 and 
pixel true

 Variable ARC controls

 Aspect ratio adjustment according to embedded WSS/VI/AFD information

 User-selectable color for the internally-generated background, 1…8 colors 

 Support for up to twelve frames of delay through the entire video path

 Clean cut transition during aspect ratio change

 SDI video clipping

 Video noise reduction and detail enhancement

 Video proc amp controls

 Color correction

 I-Wings, 3D Combine, and 3D Undo modes

ANC
Processing

 Trans-coding of CC or TT according to input and output video formats

 WSS, VI, and AFD processing: detection, insertion or re-insertion

Audio
Processing

 Embedded audio processing (de-embed, delay/sync, sample rate conversion, embed) 
for sixteen channels (four groups)

 Discrete audio processing for eight channels (four AES pairs or eight analog mono 
channels)

 Audio proc amp controls (gain, phase invert)

 Handling of any embedded compressed audio with fixed delay

 24-bit audio processing; word-length control on embedded and AES outputs

 Support for compressed and linear PCM in the same audio group

 Support for AES input sampling rates from 32 kHz to 108 kHz

 Audio delay that matches video propagation plus additional user delay of up to 2.5 
seconds

 Audio input delay range of 0-1.25 seconds.

 Audio output delay of 0-1.0 seconds

 Plug-in advanced audio submodule option with software license keys for Dolby Digital/
Dolby E decode and encode, DTS® Neural Loudness Control and DTS® Neural 
SurroundTM Up/Down Mix and MultiMerge
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Other  10/100 Ethernet connectivity

 Store-and-recall AFD presets through CCS-P and SNMP

 User-selectable LOV modes: Pass, Freeze, Black, and Test Pattern

 Built-in SD/HD/3G test generator containing cross hatch pattern, color bar signal, black, 
white, and horizontal sweep with chroma or luma-only signals

 Clean handling of hot switch on input

 Front panel and CCS Pilot control accessibility

 Store-and-recall of control parameters via CCS applications and control panels

 Logo/trouble slide storage and presentation capability

Options The base X50-AV-2PS model is a 1RU frame sync, converter, and processor with audio 
processing and dual power supplies. Table 1-1 lists the available options. For 
unbalanced-to-balanced AES connections, we recommend the AES baluns listed on 
page 10.

Also, recommended is the 10REMTOOL for removing 1.0/2.3 FPB connectors on the X50. 
This product is available from White Sands Engineering. See the following document:

http://www.whitesandsengineering.com/downloads/catalog.pdf

Table 1-1  X50 Orderable Options

Name Description

OP+SFP+TR13P Small Form Factor Pluggable (SFP) for fiber optic modules: 1310 nm wavelength 
transceiver with pathological support for baseband video

OP+OP+SFP+TR27P 
to OP+SFP+TR61P

Small Form Factor Pluggable (SFP) for fiber optic modules: 1270 to 1610 nm wavelength 
transceivers with pathological support for baseband video

X50OPTCAB-AES BNC-to-DIN 1.0/2.3 AES interface cable

X50OPT-ADVAUD APM (Audio Processing Module) plug-in advanced audio processing; this hardware 
requires software key license options 

X50OPT-SK-DDD Software key license for one Dolby Digital Pro decoder (5.1 or 2.0) 

X50OPT-SK-DDE Software key license for one Dolby Digital Pro encoder (5.1 or 2.0)

X50OPT-SK-DED Software key license for one Dolby E encoder

X50OPT-SK-DEE Software key license for one Dolby E encoder 

X50OPT-SK-DTS Software key license for DTS Neural Technologies options 

 Three software key licenses are required for DTS Neural Surround UpMix or DownMix 
or 5.1 DTS Neural Loudness Control

 Four software key licenses are required for DTS Neural Surround MultiMerge

 One software key license is required for 2.0 DTS Neural Loudness Control 
  

http://www.whitesandsengineering.com/downloads/catalog.pdf
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Front and 
Back Views

Figure 1-1  Front and Back Views
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Pinouts

Figure 1-2  Female Back Panel Data Pinouts

Figure 1-3  Female Back Panel GPI Pinouts

Figure 1-4  Female Back Panel Analog Audio Input and Output Pinouts

Signal 
Flow

Figure 1-5 on page 6 illustrates the signal flow for the X50.
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2 Installation
Preparing for Installation
Prior to installing your system, ensure that certain environmental and electrical conditions 
are met.

Electrical Requirements
The X50 power supplies have a universal input of 100-240 VAC at 47 to 63 Hz (nominal), 75 
W. There is no voltage selector switch. 

Each frame has space for two power supplies; however, a single power supply can meet the 
requirements of a fully-loaded frame. 

Environmental Requirements
X50 units are cooled by forced air drawn in from the front, and exhausted through the rear. 
There must be free passage for air flow at the front and back of each unit to allow for 
adequate ventilation. Take care to select a dry, well-ventilated location with a minimum of 
dust.

X50 units are designed for mounting in a standard 19-in. (48-cm) rack using front-mounting 
ears and rear support brackets, occupying a 1RU vertical space of 1.75 in. (4.4 cm). 

When installing an X50 in a rack, ensure that there is adequate space behind the mounting 
ears and clearance for the rear connecting cables. Allow about 10 inches (25 cm) of slack in 
the rear connecting cables for frame access and maintenance.

After unpacking the frame, and before installing into a console or rack, allow at least 30 
minutes for temperatures to equalize and to eliminate any condensation that may have 
developed. X50 frames require an ambient temperature of 41º to 95º F (5º to 35º C) with a 
relative humidity of 10-90% (non condensing).

Rack 
Mounting

Although the pre-installed frame-mounting ears provide the main support for the X50 
within a rack, you must install arms, brackets, and a cable relief bar at the rear of the unit to 
support the weight of cabling and frame stacking. 
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The following items are included:

 Rear support arms (164-000306Q00)

 Cable tie bar (164-000305Q00)

 Brackets (741-983A_Q)

 Bracket screws (4-40X1/4 PH_Q)

 Tie bar screws (6-32X3/8 PH)

 Rack Ears (164-100062Q00)

Note: The frame mounting ears and the rack support brackets are reversible. You can install 
them with the ears at the front and support brackets at the rear, or with the ears at the rear 
and the support brackets at the front.

Figure 2-1  Mounting Ears in Front Position

The following procedure describes how to install the rack supports.

1 Locate the support package in the box, consisting of two support arms, two brackets with 
screws, a tie bar, and tie bar screws. (See Figure 2-2.)

Figure 2-2  Rack Support Brackets

Cable tie bar

Rear support arms

Tie bar screws

Brackets
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2 Attach the brackets to the sides of the frame using the screws that are provided. 
(See Figure 2-3 on page 9.)

CAUTION

To prevent damage to components inside the frame, do not use screws longer than 
those provided. 

Figure 2-3  Bracket Installation

3 Attach the cable relief bar between the two support arms using the screws that are 
provided.

You can secure the cable relief bar through any of the screw holes on the arm. (See 
Figure 2-4 on page 9.)

Figure 2-4  Attaching the Cable Relief Bar

4 Push the X50 into the front of the rack, and attach the frame’s front-mounting ears to the 
rack using the appropriate screws (not provided).

5 Slide the two arms into their slots from the back of the frame and attach the arms to the 
back of the rack (Figure 2-5).
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Figure 2-5  Installed Support Arms and Cable Relief Bar

Jumpers The analog audio input on the X50 can be set to either 600 or Hi-Z impedance. For 
instructions on changing the jumper settings, see Changing Jumper Settings on 
page 118.

Selecting 
an External 
Balun

The following baluns from Neutrik are recommended for the unbalanced-to- balanced AES 
connections on the X50:

 NADITBNC-F: Female chassis XLR 110 input to female BNC 75 output 

http://www.neutrik.com/fl/en/audio/210_309314683/NADITBNC-F_detail.aspx

 NADITBNC-M: Female BNC 75 input to male chassis XLR 110 output 

http://www.neutrik.com/fl/en/audio/210_2044239418/NADITBNC-M_detail.aspx

 NADITBNC-FX: Female cable end XLR 110 input to-female BNC 75 output 

http://www.neutrik.com/fl/en/audio/210_1576769505/NADITBNC-FX_detail.aspx

 NADITBNC-MX: Female BNC 75 input to male cable end XLR 110 output 

http://www.neutrik.com/fl/en/audio/210_1923043515/NADITBNC-MX_detail.aspx

http://www.neutrik.com/fl/en/audio/210_309314683/NADITBNC-F_detail.aspx
http://www.neutrik.com/fl/en/audio/210_2044239418/NADITBNC-M_detail.aspx
http://www.neutrik.com/fl/en/audio/210_1576769505/NADITBNC-FX_detail.aspx
http://www.neutrik.com/fl/en/audio/210_1923043515/NADITBNC-MX_detail.aspx
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Configuring Network Settings
When shipped, the X50 is configured with a default IP address, subnet mask, and default 
gateway. If you intend to control the unit remotely, or connect it to a network hub/switch 
along with other X50 units, you will need to reconfigure the IP with unique network 
settings. Local control (with a direct Ethernet crossover connection to a PC) does not require 
any IP configuration.

Supported Network Protocols
The X50 supports the following network protocols for remote/network control: 

 CCS Protocol 

 HTTP

 SNMP

Making Required Hardware Connections
If you are connecting an X50 directly to a PC (no network connection), connect one end of 
a crossover Ethernet cable to the Ethernet RJ-45 port on the back of the frame, and the 
other end to the PC Ethernet port. If you are establishing a network connection, connect a 
straight-through 10/100Base-T Ethernet cable between the X50 Ethernet port and the 
network hub/switch.

Setting IP and Subnet Mask Addresses
To allow devices to communicate on a network, you need to set all X50 devices to the same 
subnet (network location). When shipped, X50 units are configured with the same default 
IP (device identifier) and subnet addresses. These addresses need to be changed so that 
each unit is uniquely identified and the network location of all units is accurately reflected. 
An IP address is made up of a four-item set of numbers (octet). For a class C network, you 
must change the first three items in the octet to identify the location (address) of the unit 
on your network, and also change the last item in the octet to uniquely identify the device 
from other X50 units. Consult your IT department for suitable address ranges, subnets, and 
gateways for your network. 

Default IP Address and Subnet Mask
The default (factory-configured) IP address for every X50 unit is 192.168.100.250. 

The default subnet mask address for every X50 is 255.255.255.0.

Setting the IP Address of a Single Unit using the Web or Client 
Desktop App
Once you have accessed the Selenio X100, the interface for monitoring and control of the 
device is functionally identical, whether you are using Silverlight or the WPF client 
application. Follow these steps to set the IP address: 

1 Log in using default IP address in Desktop Client or populate IP address in the address bar 
for the web browser supported by the Silverlight plugin (see Configuring for Web Browser 
Control for information on installing Silverlight, if required).
  

H_225008
H_225008
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2 Click Configuration on the right of the bar at the top of the screen and then select Tree.

3 Choose System Setup from the menu. 
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4 Enter an appropriate Device IP, Subnet Mask and Gateway for your network. 

5 Select Save IP and then select the Yes option. 

6 Open a new Desktop Client or Webpage with the modified IP settings.

Setting the IP Address of a Single Unit with a Local or Remote 
Control Panel
Follow these steps to configure the network addresses using a local or remote control 
panel:

1 Follow this path: System Config > Setup (in the RCP, select Device Setup).

2 Scroll to the Device IP parameter, and then press Enter.

If this is a new unit being configured, the default IP displays. Otherwise, the current IP 
address of the unit displays.

3 Change the IP address by following these steps:

a Press Enter to navigate to one of the four number sets in the octet.

b Modify the address value by using the scroll knob to set a new number.

c Press Enter to move to the next item in the octet, and then repeat step (b) above.

d Press Exit when you are finished configuring the address.

4 Scroll to the Subnet Mask parameter, and then press Enter. 

If this is a new unit being configured, the default subnet mask displays. Otherwise, the 
current subnet displays.
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5 Repeat the procedure described in step 4, this time for the subnet mask.

6 Scroll to the Gateway parameter, and then press Enter. 

If this is a new unit being configured, the default gateway displays. Otherwise, the current 
gateway address displays.

7 Repeat the procedure described in step 3, this time for the gateway parameter.

8 Select Save IP, and then press Enter.

9 Select Yes option and then press Enter.

10 Press Exit to return to the Setup menu. 

Rebooting the X50 is not required.

Setting the IP Addresses of Multiple Units
If you have multiple X50 systems that require network configuration, you will need to set 
unique IP addresses and assign a subnet mask and gateway address for each of them one at 
a time. The following procedure summarizes the required steps:

1 Apply power to the first X50 unit with a frame-mounted local control panel. 

When ready for configuration, the main X50 menu shows on the display screen.

2 Configure the network settings for the first X50, as described in the procedure on page 13. 

3 Restart the X50 unit.

4 Plug in the next X50 system, configure its network information, and then restart the unit.

Follow this procedure for all remaining X50 units that require configuration.

5 Connect all X50 systems and remote panels to a network hub or switch using a 10/
100Base-T Ethernet cable.

6 Ensure that all configured X50 units are detected on the network. 

To do this, press Remote on the front panel. All X50 units configured with the same subnet 
mask address will display (you will see a list of all detected IP addresses). 

If a unit or RCP is not detected, ensure that the subnet mask address is accurate. 
Alternatively, confirm that all units were restarted after configuring any network settings.

Remote Control of the X50
This section provides the following general configuration procedures:

 Configuring for Web Browser Control on page 15
 Using the Selenio X50 Client Desktop Application on page 15
 Remote Control via Control Panel (on page 16)
 Selecting a Remote Unit to Control on page 19
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Configuring for Web Browser Control

The control interface allows up to 10 simultaneous monitoring connections. Each 
connection shows device fault and parameter information. When a change occurs to a 
device, such as a fault or a parameter change, that change will appear on the monitoring 
screens of other users. 

Note: Navigator version 4.6 no longer supports a specific GUI for the X50. Instead, a 
Silverlight web server launches when you click on a code-updated X50 in Navigator.

Logging In To the X50 Control Interface
To open a browser connection to an X50, follow these steps: 

1 In your browser, enter the IP address of the X50, and then click Enter to connect. 

If the X50 is in a failed state (i.e., disconnected), then you will see a “browser cannot display 
the page” or “browser could not connect” message. 

2 Enter a defined user name and password. 

The default user name is Administrator, and by default there is no password (leave the field 
blank). 

3 Click Enter. 

The X50 control interface appears. 

The number of PCs connected to the X50 has an impact on receiving data in a timely 
fashion. If a large number of users are logged into the frame, response time may become 
slower. Up to ten separate PCs can be connected to the X50 at any one time. If additional 
users attempt to connect to the X50, they will receive a message: 

Server Busy. Please try again later. 

When you are not actively using the interface, please log off out of the system.

Exiting the Control Interface
To log off the X50 control interface, do one of the following: 

 Close your browser. 

 Navigate to a different page in your browser.

 Click Logout in the top right corner of the control panel. 

Using the Selenio X50 Client Desktop Application
The Selenio X50 Client Desktop Application uses Windows Presentation Foundation (WPF) 
as an interface to control and monitor Selenio X50 devices. 

Installing the Selenio X50 Client Desktop Application
1 Download and run the Selenio Parametric Control 1.2.0.exe installer. 

An InstallShield Wizard launches. 
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2 Follow the instructions that appear on the screen. 

3 When installation is complete, click Finish. 

Launching the Selenio X50 Client Desktop Application
1 Enter the IP address of the X50 device in the Controller IP field. 

2 Select a User Name from the menu, enter the password associated with that user, and click 
Login. 

A paned display box opens. 

For a standard parameter list as described in the Controls chapter of this manual, click the 
Tree button. 
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Using the X50 Silverlight Application
Web Browser Control requires the MS Silverlight plug in. Go to https://www.microsoft.com/
silverlight/ to download the software and install instructions. Silverlight is not supported on 
all Web browsers. If your browser does not support Silverlight, the option will not appear 
when you enter the IP address of the Selenio X50 device. 

If the computer you are attempting to log in from supports but does not have Silverlight 
installe, when you enter the IP address of the Selenio X50 frame, the following message will 
appear: 

Note: If you are using Windows 7 operating system, a security dialog box may appear. Click 
Ok to confirm that you want to go to the page. If you click No on this dialog box, you will 
instead see a "Page cannot be displayed" message.

An internet connection is not required for the PC to complete the install. Follow the 
instructions that appear on the screen. When installation is complete, click Finish. 

The Selenio Controller Desktop App functionality is the same as documented for the 
Silverlight application. 
  



Chapter 2
Installation

18

  
Preparing for Remote Control via Control Panel

Figure 2-6  Network Configuration Diagram

Control panels remotely control X50 units via broadcast. You will need to configure the 
switchers and routers in your network accordingly.

Follow these steps to prepare your X50 models for remote control:

1 Reconfigure each X50 with unique IP addresses and other appropriate network settings, 
including shared subnet mask addresses. 

See Setting IP and Subnet Mask Addresses on page 11 for details.

2 Restart each X50, and then wait 20 seconds to allow for network detection.

Remote PC-based software control and monitoring options

SNMP Web browser Third -party 
control software

HP 
Openview

TM

Microsoft
Internet 

Explorer 6.0 
or later

CCS 
Protocol

CCS 
Navigator

CCS application

X50 broadcast-quality up/cross/downconverter 

3rd party hub or switch

multiple path converter /synchronizer
X85-3G/X85HD/X75SD 

X50 broadcast-quality up/cross/downconverter 
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3 Connect all X50 units to a TCP/IP-based network hub or switch using 10/100Base-T 
Ethernet cable. 

4 Discover all units found on the network, and then select the one you wish to control.

Selecting a Remote Unit to Control
You can remotely control all X50 units that share the same subnet. Follow these steps:

1 Ensure all connections and network settings have been made.

2 On the X50, press the Remote button to bring up a list of available units for control (see 
Figure 2-7).

Figure 2-7  List of Systems Available for Remote Control

The <local device > option shown on-screen represents the unit you are using (the local 
unit that is in front of you), and is always available on this list. An asterisk (*) beside the 
name indicates that this is the remote system currently being controlled by the panel.

Note: Instead of IP addresses, you can give alphabetical names to individual X50 units that 
will appear in the list. To do this, see the Machine Name parameter.

3 Use the control knob to scroll through the list of available X50 devices, highlight the unit 
you wish to control, and then press Enter.

The X50 screen reads Connecting...

4 Wait a few moments.

The menu of the selected X50 unit appears along with all of that unit’s settings. 

5 Operate the selected unit as required. 

Once a unit is selected for remote control, all front panel features operate as if you were 
actually at the front panel of the selected remote unit. This means that the VFD panel, 
status indicators, and buttons (with the exception of the Remote and Option button) all 
control and/or reflect the status of the remote unit, not the one you are physically 
operating.

Note: The light on the Remote button flashes while the unit is remotely controlling a 
device.

6 To switch to another unit, or to control the local device you are physically operating, press 
the Remote button, and then select a new device to control. 

7 Select <local device > to resume normal single-unit operation.
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Configuring SNMP Support
With SNMP support, you can use a standard MIB browser to monitor parameters and 
alarms. You must set SNMP options using CCS Pilot or Navigator. Before you can configure 
SNMP support, you must discover the X50. 

Setting SNMP Options
Devices that support SNMP will have an SNMP tab in the Configuration window. To 
configure an X50 that supports SNMP, follow these instructions. 

1 While your CCS software is in Build mode, right click on the X50 and choose 
Configuration. 

The Configuration window opens.

2 Click the SNMP tab, and then click the Read button. 

The CCS network polls the module and retrieves its current settings. It fills in all the fields on 
the SNMP tab of the Configuration window with the settings that are on the device. 

Figure 2-8  SNMP Tab on device Configuration Window 

In the top left portion of the window are SNMP Agent settings.  

Table 2-1  SNMP Agent Fields of SNMP Tab

Field Function

Port Number (Can be from 0 to 65535) The network port used 
by the SNMP agent; port 161 is the default for 
X50

Read 
Community

Has to match the “read community” setting in 
your MIB browser
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Below the SNMP Agent settings are System settings. The information in these fields 
describes the device that is currently selected in the Navigation window. This is 
user-defined information that, once provided by an administrator, is available on the device 
when it is retrieved by a MIB browser. 

The Trap Destination IP Addresses field contains a list of IP addresses that will receive 
SNMP traps. It is in the format IP Address:Port Address:SNMP version. 

3 To add new Trap Destination IP Addresses, see Adding New Addresses for SNMP 
Traps on page 21. To modify them, see Modifying an SNMP Trap Destination on 
page 22.

4 (Optional) If you wish the device to reboot automatically when you send the new 
configuration to it, place a check beside Reboot device after performing transfer. 

5 Click Write to send the new configuration to the device. 

6 If you did not place a check beside Reboot device after performing transfer in step 6, 
click Reboot now and your changes to the configuration will take effect. 

Note: The device must be rebooted before changes will take effect. 

Adding New Addresses for SNMP Traps
To add a new SNMP trap destination, follow this procedure:

1 Click Add beneath the Trap Destination IP Addresses field. The Add Trap Destination 
window opens. 

Write 
Community

Has to match the “write community” setting in 
your MIB browser

Enable 
Authentication 
Traps

When checked, authentication traps are sent if 
the read or write community doesn’t match 
between the SNMP agent and MIB browser

Enable SNMP 
Agent

When checked, SNMP support is available; if not 
checked, SNMP support is disabled

Table 2-2  System Fields of SNMP Tab - MIB-2 System Information

Field Explanation

Description The default is “Leitch SNMP Agent”

Location The physical location of the device

Contact The contact person for this device

Name Name of the device

Table 2-1  SNMP Agent Fields of SNMP Tab

Field Function
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Figure 2-9  Add Trap Destination Window

2 Choose the SNMP version that you would like to use for traps. 

3 Choose the IP address of that trap destination. 

4 Choose the port number. The default is 162, but an administrator can set this to any 
number between 0 and 65535. 

5 Click Apply. A new line is added in the Trap Destination IP Addresses field. 

6 Repeat steps 2 through 5 to add more rows to the window. 

7 Click OK to return to the SNMP tab of the Configuration window. 

Modifying an SNMP Trap Destination
To modify a trap destination, follow this procedure:

1 In the Trap Destinations IP Addresses list, click on the item you would like to modify.

2 Click the Modify button. The Modify Trap Destination window opens. 

Figure 2-10  Modify Trap Destination Window

3 Choose the SNMP version of the traps using the radio buttons at the top of the window. 

4 Enter the IP address of that trap destination in the IP Address field.

5 Enter the port number in the Port Number field. 

The default value is 162.

6 Click Apply. The selected entry in the Trap Destination IP Addresses field is updated. 

7 Repeat steps 2 through 6 to further update the row. 

8 Click OK to close the Modify Trap Destination window. 
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Configuring Third-Party SNMP Software Control 
SNMP is an industry-standard protocol that allows other manufacturers’ control software to 
remotely monitor and control the X50.

Harris provides MIB files that can be downloaded from the website. Two general MIB files 
(leitch.mib and ccsAlarm.mib) set up the structure to define parameters and alarms. Once 
these two MIBs are installed, you will want to install a MIB for each distinct module for 
which you wish to set up third-party software control.

You can use any standard MIB browsing software with your X50. 

1 Make the required network connections between the X50 unit(s) and your PC with installed 
SNMP browser/control software.

The SNMP configuration process for the X50 directs the SNMP agent where to send alarms 
(SNMP traps). This file must be modified before it is loaded back to the X50. For information 
on configuring SNMP, see page 20.

2 Load the leitch.mib file into your SNMP browser/control software.

This MIB sets up the basic structure for product specific Harris MIBs. It can be found under 
the Private > Enterprise branch, and sets up the leitchProducts and leitchCommon 
sub-branches. 

The leitchCommon branch is initially empty. The leitchProducts branch contains folders 
for different families of Harris devices—for example, LeitchX75, NEO and X50.

3 Load ccsAlarm.mib into your SNMP browser/control software.

This MIB adds a ccsAlarms sub-branch to the leitchCommon folder. When it is installed, 
you will be able to receive traps with proper information as to where the alarms are 
triggered from.

4 Load product-specific X50 MIB files into your SNMP browser/control software.

A product-specific MIB provides a clear path to the parameters and alarms on the device. 
Harris MIBs can be downloaded from our website.

X50 MIBs will appear in the X50 folder under the leitchProducts folder. See Figure 2-11 on 
page 24.

5 Configure your MIB browser to connect to the unit by entering the IP address, Port (if you 
have changed the Port from its default in the configuration), and other standard 
configuration settings. 

Your browser should now be able to connect to the SNMP agent running on the X50 unit. If 
you wish to receive traps, start up the trap receiver in your MIB browser software. 

Note: To verify that your configurations are correct, you can walk MIB2.
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Monitoring and Control Using MIBs
Each X50 unit’s MIB can be fully expanded. When you expand an X50 MIB node in the tree 
view, there are three sub-folders (see Table 2-3). 

To view a complete list of the parameter settings on the X50, walk the MIB for that X50, 
walk the X50 at an IP address, or walk the X50 type.

Figure 2-11  Typical MIB Loaded into NuDesign MIB Browser

Table 2-3  MIB Sub-Folders

Tree View 
Item Contents

Objects Lists the parameters for the device; all configurable and read-only 
parameters appear here (see Figure 2-11)

Identities Lists the alarms information for the device which is used by the 
MIB browser to make trap messages more meaningful (see 
Alarms in MIB Browser on page 25.)

Conformities A group of standard MIB information that guarantees that the 
MIB conforms to standard SNMP format
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Navigating Parameters in a Leitch MIB
X50 MIBs make it possible to view a parameter’s range, walk a device or a frame, or receive 
alarm traps for a device (see Figure 2-12). For details on accessing these features, see the 
documentation that accompanies your third-party control software.

Figure 2-12  Alarms in MIB Browser

Parameters that have a limited list of options have two listings under the Entry branch of 
the tree. Parameters that have a range (as in a slider) of options have four listings under the 
Entry branch of the tree.

For information on the parameters for each individual device, see that device’s 
documentation, posted on our website. Some Harris products have HTML forms that display 
their parameters, and these are also posted on our website.

Table 2-4  Sub-Branches Under a Parameter in a Leitch MIB

Sub-Branch Contains

Slot ID  (Does not apply to the X50)

Value The current setting of this parameter

High Range 
(slider ranges only)

The top value of this parameter

Low Range (slider ranges 
only)

The bottom value of this parameter
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3 Controls
Overview You can control the X50 using many different interfaces:

 Local front panel X50 controls

 Remote front panel controls on other X50 units

 CCS Level 3-enabled control hardware and software products

 X50 Web browser

For detailed information about the operation of Dolby and DTS Neural audio options, see 
Advanced Audio Processing on page 67.

Front Panel 
Controls

The X50 supports local and remote front panel control, CCS software, CCS-enabled controls 
panels, SNMP, and web browsers. At the control panel, you can change parameters using 
the rotary switch, push buttons, status LEDs, and VFD. When using the control panel, you 
will find some entries in the main menu begin with a + symbol. This indicates there are 
multiple levels for that item. The complete list of control parameters is available from our 
website.

Figure 3-1.  X50 Controls and LEDs

Rotary knob

Pushbuttons

LEDs
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Push Buttons

LEDs When LEDs are lit, the item next to the LED is either selected, enabled, or present. A 
flashing LED indicates the item is in an error condition. An LED that remains unlit is either 
not applicable, or—in the case of Rate—indicates an output frame rate of 50. The Dolby 
LED illuminates when an AAP is configured as a Dolby E or Dolby Digital encoder, and the 
encoder is currently operating.

Table 3-1  Push Button Controls

Name Function

Enter Selects or “takes” an option or value in a parameter

Exit Exits from one level in the parameter tree to a higher lever in the tree

Default Resets all of the X50 parameters to their default values, and flashes when 
you have selected a default value for a parameter (to reset all of the 
parameters using this control, you must press and hold the button for one 
second)

Remote Enables the controls to operate other remote X50, X75, and X85 units (to 
activate this control, you must press and hold the button for one second)

Status  Displays the current machine status and/or error conditions (the VFD 
switches back to control mode to display the menu structure when you 
press the Enter or Exit button)

 Hold the button for one second to obtain a Faults list. (Before the alarms 
in the list are operational, you must enable them, either in the Faults list, 
or in the X50 software GUI. To enable an alarm in the Faults list, select 
the line, press the Enter button, and then select Enable.)

 If the square beside the item is filled, the alarm has been triggered.

Help Displays a brief description of a selected parameter’s function (hold the 
button for one second to view the control panel’s display options, including 
intensity, backlight, screen saver, and Lock Panel*)

*The Lock Panel feature prevents the enabling of a function by accidental activation of a button. 
Press Default + Exit to escape this feature.

Table 3-2  Left-Side LEDs

Name Meaning when Lit

Power 1 and Power 2 Indicates which power supplies are in use

Mem Active Shows that the internal or SD card memory is in use; normal 
operation of the X50 may be interrupted

Audio Card Indicates the presence of an advanced audio module (future use)

Upgrading Indicates the X50 software is being upgraded; normal operation is 
interrupted
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Main Menu Items

Note: Certain video/audio inputs and outputs can be disabled by the power-saving controls 
under System Setup > Green (Power Save). If a selection or a control related to an 
interface is missing, check its power save status.

Auto Routing
Active Video

Input

The read-only Auto Routing Active Video Input parameter (Video > Status) indicates 
which video input is currently in use when the Auto Routing feature is operating. Possible 
values are: Analog Video, SDI 1/Fiber, and SDI 2.

Table 3-3  Main Menu

Name Function

Video Provides parameters for changing video settings

Audio Provides parameters for changing audio settings

Reference Sets the reference standard for the system

System Setup Sets the options for general system setup; includes version information, license 
credits, GPI settings, scripts, power save options, IP address information, output 
formats, and input audio

Input Video Select Selects the video source to be processed

SDI 1 Out Format Selects the output video format on SDI 1 

SDI 2 Out Format Selects the output video format on SDI 2

Analog/HDMI Out Select Selects the video source for the analog/HDMI video outputs when the SDI Routing 
Mode is set to Dual

HDMI Out Select Selects the video source for the HDMI video output when the SDI Routing Mode is set 
to Linked

Component Out Select Selects the video source for the component video output when the SDI Routing 
Mode is set to Linked

Composite Out Select Selects the video source for the composite video output when the SDI Routing Mode 
is set to Linked

Output Frame Rate Sets the output frame rate

Input Audio Select Selects the source audio to be processed 
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Web Browser Control

The Configuration page of the web browser control provides access to parameters (Tree) 
and to administrative privileges (User Account).

Figure 3-2.  Configuration Page

Figure 3-3.  Web Browser Tree View
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System Presets
Up to ten parameters in the X50 can be saved to System Presets, for quick recall at a later 
time.

You can save to--and load from--the following locations:

 Control panel

 SD-card

 Web browser user interface

To save and load presets at the control panel, press and hold the Help button. Then follow 
Options > Panel Presets.

To save and load presets using the SD card, press and hold the Help button. Then follow 
Options > SD Card Presets.

To save and load presets using the web browser user interface, set the UI to Tree View. 
Then in the bottom left corner, select either Load Preset or Save Preset.

Figure 3-4  User Interface Preset Controls

To save presets locally or on a SD card, go to the front panel of the X50. The presets are 
accessible at: System Setup > Load Preset and Save Preset.

Note: The control panel screen indicates whether a Preset is stored in the panel, or on an 
SD card. A hyphen beside the filename (-) indicates the logo is stored in the X50 panel, and 
a hash (#) symbol indicates storage on an SD card. Thus, it’s possible to pull up Presets 
both from the panel and the SD card at the same time, even if they have the same filename. 
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Faults (Alarms)
The Faults page in the user interface provides information that includes:

 Fault Name

 Error Level

 Enable/Disable capability

 Priority (1 to 5 is Minor; 6 to 10 is Major)

 Trigger in seconds

 Clear in seconds

 Acknowledgment

 Active/Inactive status

You can sort the faults under these topics and by their ID number. Also, you can select 
faults individually (Ctrl + click) or in a batch (Shift + Ctrl + click), and make changes to them 
using the options shown on the right side of the UI screen.

Figure 3-5.  Faults Page

Unit Recovery Using Failsafe Load Procedure

In the unlikely event of a loss of control due to software corruption, follow these steps:

1 Download the latest X50 firmware from the Imagine Communications website to a PC 
connected to the X50.

2 While holding the Enter + Status buttons simultaneously, power cycle the unit.

3 Continue to hold both buttons until the image on the front panel display screen returns to 
the Imagine Communications logo. 

The unit is now ready for the failsafe firmware upgrade.

4 Unzip the x50upgrade.exe file within a folder. 

5 Launch the file x50Upgrade.exe to open the Uploader utility. 

6 Type the unit's IP Address into the appropriate field and then press the Upload button. 

When the procedure is complete, a notification appears.
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Aspect Ratio Conversion
You can set the output aspect ratio conversion using Custom, Standard, or Automatic 
controls. These three methods are found in the ARC Preset parameter, with the following 
options.

 Custom

 Standard ARCs

 Anamorphic

 4:3 Pillar Box

 14:9 Pillar Box

 16:9 Cut

 4:3->21:9 Ltr

 16:9 Letter Box

 14:9 Letter Box

 4:3 Cut

 16:9->21:9 Ltr

 Automatic ARCs

 AFD

 AFD - ALTR

 VI

 VI - ALTR

 WSS

 WSS - ALTR

Depending on the current conversion mode (Up, Down, Cross, or SD-ARC), different 
subsets of these options will be in effect. Thus, for example, an ARC setting that is visible in 
upconversion may not be visible in downconversion.

Note: In some regions, SD-SDI normal analog blanking is not part of the 4:3 active video 
area, causing the 4:3 image to have an active video length of 702 (PAL/625) or 704 (NTSC/
525) instead of 720. In these situations, the ARC will need adjustments. Use the SD Width 
parameter (Video > Scalar x > Advanced) to set the module to either 720 (default) or 
702(PAL)/704(NTSC).

Custom ARC To make a custom ARC setting, select options in the Advanced, Variable, and Crop 
parameters of Scalar 1 and Scalar 2. 

Note: When individual values are matched with a particular pre-defined standard aspect 
ratio, ARC Preset will change, to reflect that matching standard aspect ratio. 

Automatic
ARC

Active Format Description (AFD), Video Index (VI), and Wide-Screen Signalling (WSS) are 
different systems in which embedded data automatically control the output aspect ratio. 
When you set ARC Preset to AFD, AFD-ALTR, VI, VI-ALTR, WSS, or WSS-ALTR, the X50 
converts the aspect ratio according to the upstream AFD, VI, or WSS code. 

The x-ALTR versions of these options interpret the code in an alternative way.
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AFD transmits data in the VANC space of the SDI signal, enabling both 4:3 and 16:9 
television monitors to optimally present video with preset ARC and safe area information. 
Without AFD, converted video may appear distorted or “cut off” when it appears on 
different monitors. 

See Figure 3-6 on page 34 for a comparison of AFD and non-AFD aspect ratio conversion.

Figure 3-6.  AFD and Non-AFD ARC

VI provides embedded code in 525-line and 625-line component digital video signals. This 
code makes it possible for picture and program related source data to be carried in 
conjunction with a video signal.

WSS is embedded code in a 625-line system. It contains information on the aspect ratio 
range of the transmitted signal and its position as it would appear on a conventional 4:3 
display.

Figure 3-8 on page 36 and Figure 3-9 on page 37 show the different AFD, VI, and WSS 
code selections. Figure 3-7 on page 35 explains the meanings of the diagrams.

SD-SDI 4:3 HD-SDI 16:9

Full frame Pillarbox

Down
Up

Postage stamp

Full frame

SD-SDI 4:3

16:9 Letterbox

SD-SDI 4:3

Up

Postage stamp

Full frame

HD 16:9

Using active format 
description (best result) 

Without active format description 
(undesirable result)

Using active format 
description, the original image 

information is maintained 
throughout the entire 

conversion , creating the best 
possible viewing area .
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Figure 3-7  AFD Diagram Explanation

Bounding box represents
the coded frame.

The smallest rectangle enclosing
the white regions indicates the area
of essential picture information.

Black regions indicate areas
of the picture that do not
contain useful information and
should be cropped by the
receiver where appropriate.

Gray regions indicate areas of the picture
that may be cropped by the receiver
without significant loss to the viewer.
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Figure 3-8.  AFD Descriptions for 4:3

AFD 4:3 code and description

Illustration in a
4:3 coded frameWSS name

16:9 Top

14:9 Top

>16:9 

Full Frame

16:9 Center

14:9 Center

Full A 14:9 

None

None

Description

Image with a 16:9 aspect ratio and with an
alternative 4:3 center as a vertically centered

letterbox in a 4:3 coded frame

alternative 14:9 center as a vertically centered
Image with a 16:9 aspect ratio and with an

letterbox in a 4:3 coded frame

Image with a 4:3 aspect ratio and with an
alternative 14:9 center in a 4:3 coded frame

Image with 14:9 aspect ratio as a vertically
centered letterbox in a 4:3 coded frame

Image with a 16:9 aspect ratio as a vertically
centered letterbox in a 4:3 coded frame

Image is full frame, with an aspect ratio that is
the same as the 4:3 coded frame

Image with aspect ratio greater than 16:9 as
a vertically centered letterbox in a 4:3 coded

frame

Image with a 14:9 aspect ratio as letterbox at
the top of a 4:3 coded frame

Image with a 16:9 aspect ratio as letterbox at
the top of a 4:3 coded frame

AFD and VI Select 
parameter options

16:9 Top

14:9 Top

>16:9 in 4:3

16:9 L

14:9 L

4:3 Full

4:3 A 14:9 

16:9 L A 4:3

16:9 L A 14:9
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Figure 3-9.  AFD Descriptions for 16:9

AFD 16:9 code and description

Illustration in a
16:9 coded frame

>16:9 in 16:9
AFD Code: 0100

AFD and VI Select 
parameter options

16:9 A 4:3
AFD Code: 1111

14:9 P
AFD Code: 1011

4:3 P A 14:9 
AFD Code: 1101

16:9 A 14:9 
AFD Code: 1110

16:9 Full 
AFD Code: 1000

16:9 Prtctd
AFD Code: 1010

4:3 P 
AFD Code: 1001

None

WSS name

None

None

None

None

Anamorphic

None

None

Description

Image with a 16:9 aspect ratio and with
an alternative 4:3 center in a 16:9 coded

frame

Image with a 16:9 aspect ratio and with
an alternative 14:9 center in a 16:9

coded frame

Image with a 4:3 aspect ratio and with an
alternative 14:9 center as a horizontally
centered pillarbox image in a 16:9 coded

frame

Image with a 14:9 aspect ratio as a
horizontally centered pillarbox image

in a 16:9 coded frame

Image is full frame, with a 16:9 aspect
ratio and with all image areas protected

Image with a 4:3 aspect ratio as a
horizontally centered pillarbox image

in a 16:9 coded frame

Image is full frame, with an aspect ratio
that is the same as the 16:9  coded

frame

Image with aspect ratio greater than 16:9
as a vertically centered letterbox in a

16:9 coded frame
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Examples of Automatic Aspect Ratio Conversion
You can enable automatic ARC controls by setting the ARC Preset parameter to AFD, 
AFD-ALTR, VI, VI-ALTR, WSS, or WSS-ALTR. When you set ARC Preset to AFD and the 
upstream video has AFD code embedded in it, the system will present the video signal in the 
appropriate aspect ratio, and generate new downstream AFD code accordingly. (You can 
confirm that AFD is available in the input signal by checking the AFD Present parameter.)

For example, in upconversion mode, an upstream signal with an AFD code of 1000 
indicates the output will be a full frame 4:3 image. The X50 creates a 4:3 Pillar Box arc, 
and the output HD image becomes a 4:3 pillar box. The resulting AFD code becomes 1001 
(4:3 center).

In another example, the X50 is in downconversion mode. The upstream signal has AFD 
code 1111, indicating a 16:9 ratio with alternative 4:3 center. If you set the ARC Preset 
parameter to AFD, the X50 creates an output of 16:9 letter box and the resulting AFD code 
becomes 1111. If you set ARC Preset to AFD-ALTR, system does a center cut ARC, the 
output becomes 4:3 full, and the resulting AFD code becomes 1000. This result is 
commonly used in the USA.

Figure 3-10 on page 39 to Figure 3-13 on page 42 show all of the conversion patterns.

In the event that the current ARC is controlled by AFD, VI or WSS, and this data disappears 
from the input signal, the X50 provides you with two options:

 Retain the current aspect ratio as set by the last AFD, VI, or WSS data.

 Reset to the aspect ratio settings that were in use before the AFD, VI, or WSS data took 
control

The Auto ARC Reset parameter controls this feature. Select Yes to have the module reset 
to older values in the event of loss of data; select No (the default) to retain the current ARC.

Some AFD code “encourages” cropping out some of the active video area. To prevent this, 
set AFD Crop Enable to Disable.

The Out Aspect Ratio parameter controls the output aspect ratio of the SD signal, and it 
will affect how the AFD performs the automatic conversion. (It is assumed that an SD signal 
may be either 4:3 or 16:9, but an HD signal will always have a 16:9 ratio.) The default value 
of the Out Aspect Ratio parameter is 4:3.

Output AFD,
VI and WSS

You can insert AFD, VI and WSS data into an output video stream either manually or 
automatically. This function is controlled by the AFD Control, VI Control, and WSS 
Control parameters. If you are using VI according to the SMPTE proposed RP-186+ 
standard as of January 11, 2007, you must ensure you have enabled the standard by setting 
Enable AFD in VI, (located in the same path as the other output control). 

The AFD embedder attempts to embed packets into the specified line after the existing 
VANC packets in the video stream. If the existing packets occupy more than 1260 pixels, the 
AFD embedding will not occur. 
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Figure 3-10.  4:3 to 16:9 Conversion

4:3 to 16:9 conversion

Illustration in a
4:3 coded frameWSS name
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Figure 3-11.  4:3 to 4:3 Conversion

4:3 to 4:3 conversion

Conversion
(Alternative)Conversion
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Figure 3-12.  16:9 to 4:3 Conversion

16:9 to 4:3 conversion

Illustration in a
16:9 coded frame
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(Alternative)Conversion

AFD and VI Select 
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Figure 3-13.  16:9 to 16:9 Conversion

AFD/VI/WSS Alignment
The following settings are required to enable AFD/VI/WSS alignment:

 The menu option Video >Data > (SDI1 Output/SDI2 Output) > (AFD Control/VI 
Control/WSS Control) must be set to Insert Auto. This is the mode in which the AFD/
VI/WSS code embedded at the output reflects the ARC setting applied to the video. 

 The menu option Video > (Scalar1/Scalar2) > ARC Preset must be set to either AFD, 
AFD-ALTR, VI, VI-ALTR, WSS, or WSS-ALTR. These are modes in which the ARC 
setting applied to the video follows the code present in the input signal. 

16:9 to 16:9 conversion
Conversion 
(Alternative)Conversion

Illustration in a
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>16:9 in 16:9
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AFD and VI Select 
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AFD Code: 1010

4:3 P 
AFD Code: 1001

None
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None

None

None

None

Anamorphic

None

None
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 The menu option Video > Scalar x > Advanced > AFD Crop Enable must be set to 
Off. If you set the parameter to On, AFD alignment will not occur.

When all three conditions are met and the video input format is interlaced, the output AFD/
VI/WSS code and new aspect ratio will be aligned with the video content. If the video input 
format is progressive, the output AFD/VI/WSS code and new aspect ratio will lag the video 
content by one frame.

AFD/VI/WSS alignment is delayed when there is a disturbance of the input video, or the 
input video selection is changed. However, the alignment will continue to operate normally 
if the input video is undisturbed and the AFD/VI/WSS code changes no more than once per 
second.

Closed Captioning and DVB Teletext Captioning
Although North America has dedicated standards for closed captioning of video (EIA-608 
and 708), many countries in Europe and elsewhere have not yet adopted formal standards. 
For these countries, closed captioning is part of the DVB Teletext System as described in 
ITU-R BT-653-3. These specifications define all Teletext Systems (Systems A, B, C, D) used in 
the world and are also known as the World System Teletext (WST). A Teletext system is 
made of several pages of various data information and CC data is described in one these 
pages. System B is used in Australia, the UK, and Germany, among other countries.

Australian closed captions are inserted on line 21/334 in analog PAL broadcast signals, as 
per the ITU-R BT-653-3. When analog PAL is produced or converted to SDTV (625 digital), a 
digitized version of the closed captioning appears on line 21/334 (in the same way line 21 
on NTSC signals is digitized and appears on the line 21 of SD-SDI signals). The document 
proposed by Free TV Australia indicates how to carry this CC data into the VANC area of 
SD-and HD-SDI signals by use of the SMPTE 334M VANC embedding protocol. For digital 
broadcasting, Australia intends to use the ETSI EN 300 472 standard that specifies the 
conveyance of ITU-R System B Teletext in DVB bit streams.

Closed Captioning and Teletext data that is embedded in the input stream is detected by 
the CC/TT Present parameter. This information is re-embedded into output video stream 
when you set the CC/TT Embed parameter to On. Closed captioning and Teletext are not 
supported when the frame rate converter is in use.

Generic Data Passing
VANC data are removed when video is converted through the scalar of the X50. The 
Generic VANC data passing function makes it possible to select one kind of VANC data 
(identified by its DID/SDID) and pass it from input to output. This requires the configuration 
of the following parameters: Video > Data > Input > Data DID (hex) and Data SDID 
(hex). Field information for the VANC data is also required for the system to understand the 
nature of the VANC data and pass it properly. The X50 can pass up to 10 packets of the 
same generic data per frame.

To pass a data type that is one packet per frame/field, set Video > Data > SDI x Output > 
Data Pass to Pass One Packet, and then configure Data Embed Field and Data Embed 
Line properly to let the system know the nature of the data you want to pass.
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To pass a data type that is more than one packet per frame, set Data Pass to one of the 
following selections:

 Pass Packets (Exact)

This selection is only available when input and output standard are same; data on 
certain lines of the input video will be copied to the same line of the output video

 Pass Packets (Same Line)

Data packets will be inserted into the same line as configured by Data Embed Line; if 
the line is not long enough for the amount of data, extra data will be inserted into the 
following line

 Pass Packets (Incremental)

Data packets will be inserted one per line into continuous lines starting from the line as 
configured by Data Embed Line

To pass data from an interlaced video standard to a progressive video standard, data must 
be present on each field of the interlaced video standard. To pass data from a progressive 
standard to an interlaced standard, ensure the frame rate combination allows data to be 
embedded into each field of the interlaced standard.

The default value for DID/SDID is ARIB data. When generic data passing is configured to 
pass ARIB data, the current audio mode is reported, and the output current audio mode is 
configurable.

VPID (Video Payload Identifier) Enable
When you set VPID Enable to No, the packet descriptor from the input will be stripped 
out, and not passed to the output.

This feature is not available in SD 525 and 625 formats.

Green-Power Save
You can reduce power consumption on the module by shutting down the following specific 
circuits:

 Video decoder

 Video encoder

 HDMI

 DARS

 SRC (AES/Analog)

 AES Outputs

 Audio Codec

 GPI

 RS-422

Select System Setup > Green (Power Save) > Yes to turn off one of the interfaces, or No 
to leave it on.
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Note: Certain video/audio inputs and outputs can be disabled by the power-saving controls 
under System Setup > Green (Power Save). If a selection or a control related to an 
interface is missing, check its power save status.

Color 
Correction

The color corrector changes the following attributes of an input signal:

 Gain

 Offset

 White Slope 

 Black Stretch 

 Gamma Correction 

These parameters include “lock” options that make it possible for you to adjust all of the 
options of a particular group in tandem, rather than separately. 

White Slope
and Black

Stretch

The white slope is comprised of G White Knee, B White Knee, R White Knee, and GBR 
White Knee Lock. Black Stretch includes G Black Knee, B Black Knee, R Black Knee, 
and GBR Black Knee Lock.

Component knees determine the amount of additional gain applied to segments at the 
ends of the RGB transfer functions in the look-up tables. 

The values displayed are a percent of the available correction. A positive white knee 
increases the slope of the last 15% of RGB values, and decreases the slope of the preceding 
15%. A positive black knee parameter will increase the slope of the first 15% of the 
transfer function by the amount entered and decrease the slope of the next 15%, to return 
to the unmodified transfer function. Each component knee is added to the total knee (the 
sum cannot exceed 100%) to produce the correction applied to the respective component.
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Figure 3-14  Examples of Increased and Decreased White Slope

Figure 3-15  Increased and Decreased Black Knees

Gamma
Correction

Gamma correction is applied to the RGB as a simple power function, and is applied to each 
component independently. 
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Figure 3-16  Example of Gamma Corrections to R, G, and B

Custom Splash Screen
You can add your station’s logo or any other graphic to the startup splash screen on the VFD 
of the X50. To add a custom graphic, follow these steps:

1 Create a 24-bit Windows bitmap file of the size 128x32, using a graphics program.

2 If the logo has a background color of black, save the bitmap file as logo.bmp

Or

If the logo has a background of white, save the bitmap file as logo-i.bmp (the application 
will invert the colors of the logo before displaying).

3 Upload the file via Navigator’s file transfer tab (or via FTP) to /config

4 Reboot the X50 to see the logo displays briefly.

Note: If both logo.bmp and logo-i.bmp exist and are valid images, logo.bmp will be 
used.

Using the Secondary Channel
The X50 provides independent horizontal and vertical phasing when you select Unlocked 
in Video > Frame Sync > SDI Phase Lock. If you select Locked, the horizontal and vertical 
phasing settings of the SDI output are locked together.

Gamma Correction

0

R
, G

, a
nd

 B
 o

ut
pu

t

R, G, and B
input

0.30

0.50

1.0

2.00

3.00
  



Chapter 3
Controls

48

  
The SDI Routing Mode makes it possible for you to make the SDI 2 output the same as, or 
separate from the SDI 1 output. If you select Dual, SDI 1 and SDI 2 can have separate 
outputs. If you select Linked, SDI 2 will carry the same output signal as SDI 1. (This setting 
also affects the available output formats for Analog and HDMI).

Note: When you adjust horizontal or vertical timing on one output SDI channel, the other 
SDI channel may produce video “glitches”. Ensure that your X50 is not on-air if you make 
adjustments to the horizontal or vertical output timing.

The Audio/Video Sync parameter provides automatic tracking of the audio and video 
signals (see Figure 3-21 on page 54). However, this timing is based on the output of the 
primary (SDI 1) channel. Because different formats may have different propagation delays, 
the SDI 2 audio and video tracking may not be aligned with SDI 1. Audio/video alignment 
always follows SDI 1; the A/V alignment on the SDI 2 channel cannot be controlled 
separately.

Frame Rate 
Conversion

The X50 provides basic automatic frame rate conversion. When the X50 enables the FRC, 
audio/video alignment is variable ±1 frame. There must be a valid reference available for the 
selected output standard, and you must enable the Sync mode in Audio/Video Sync.

When the conversion involves increasing the frame rate, frames are repeated as required; 
when converting to a lower frame rate, frames are dropped. All of the frames at the output 
are identical to the input frames with two exceptions: sometimes a frame is repeated a 
second time, and sometimes a frame is dropped. If there is a lot of motion in the video, a 
jerky motion (called judder) may appear when converting from one frame rate to another. 
This is a normal artifact of basic frame rate conversion. Closed captioning and Teletext are 
not supported when the FRC is in use.
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Composite 
Video

The X50 processes NTSC (SMPTE 170M), PAL-B (ITU 624-2), and PAL-M composite video 
that complies to ITU-R BT.470-6 standard (with burst amplitude of 300mV), as well as a 
variant that is used commonly in Brazil (with burst amplitude of 287mV). Ensure that you 
select the correct PAL-M standard for detection. An incorrect standard setting will distort 
the color level of the video. To select the PAL-M standard for detection, follow Video > 
Analog Video > PAL-M Standard, and then select either Brazil (default) or ITU-BT470-6.

Output Configuration
Obtaining a composite analog video output from the X50 is dependent on its SDI routing 
mode. Follow these steps to configure the composite video output either in Dual or Linked 
modes:

1 Under the main Video level, set the SDI Routing Mode to Dual.

This enables the Composite Out Select parameter. (When the Dual option is selected, one 
of the SDI outputs must be set to an SD format.)

Figure 3-17.  Selection of the SDI Routing Mode

2 Set either SDI 1 or SDI 2 in Composite Out Select.

Figure 3-18.  Composite Out Select Options
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Alternately, set the SDI Routing Mode to Linked. 

This action allows only one output standard on the two SDI outputs: SDI 2 will mirror SDI 1. 
A larger selection of options is now available in the Analog/HDMI Out Select parameter.

Figure 3-19.  Analog/HDMI Out Select Options

3 For composite analog output, select 525 or 625; for HDMI, select any SD- or HD-SDI output.

Auto Route 
Feature

When you set Input Video Select to Auto, the X50 automatically routes an alternate 
video source if the Primary Input selection fails. The option you select in Backup Input 1 is 
the first alternate video source; if that source fails, the next priority is given to the selected 
source in Backup Input 2. 

The Auto Switch Delay parameter makes it possible for you to set the amount of delay 
before the X50 switches to the next backup input. The adjustable range is between 0 and 5 
seconds.

If the Primary Input signal returns when the X50 is routed to Backup Inputs 1 or 2, the X50 
reverts to the Primary Input signal.

If the Auto Route Black parameter is set to Yes, the X50 also routes alternate inputs if 
black video is detected within the active picture region. The current black video detection 
status is monitored at Video > Status.

Note: Certain video/audio inputs and outputs can be disabled by the power-saving controls 
under System Setup > Green (Power Save). If a selection or a control related to an 
interface is missing, check its power save status.
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Proc 
Bypass

Proc Bypass is an option found in the SDI1 Out Format and SDI2 Out Format 
parameters. In the X50, this function bypasses the scalar and all processing (noise reduction, 
detail enhancement, color correction, etc.) but is downstream of the frame synchronization.

Output Format Selection

The SDI Routing Mode selects whether the SDI 2 output is independent or linked to SDI 1 
(This setting also affects the available output formats for SDI2, Analog, and HDMI.) 

I-Wings and 3D Modes

The default operation of the X50 is the Normal mode, found at Video > Operation 
Mode. Other Operation Mode options include I-Wings and various 3D controls.

To enable the I-Wings mode on the X50, select Live I-Wings. When operating in this mode, 
video from SDI 1 and SDI 2 input forms into one video stream. The SDI 1 input remains in 
the foreground, while video from SDI 2 input becomes the background (the “wings”).

The 3D mode is enabled by selecting 3D Left/Right or 3D Top/Bottom. When the X50 is 
operating in a 3D mode, SDI 1 and SDI 2 input video forms into one frame-compatible video 
stream for side/side or over/under (half resolution) 3DTV signals.

In both I-Wings and 3D modes, frame sync and color corrector processing blocks are 
bypassed.

To undo a 3D function, select 3D Undo Left/Right (1080i) or 3D Undo Top/Bottom 
(720p). When you select either of these options, the side/side or over/under 3D signal can 
be converted to left eye and right eye signals.

Note: 3D Undo Top/Bottom for 1080 output standards is not supported at this time.
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Audio 
Processing

For detailed information about the use of Dolby and DTS Neural options, see Advanced 
Audio Processing on page 67. 

The Input Audio Select parameter selects the audio source to be routed to all audio 
outputs. This pre-empts individual audio controls. The default Map Through option routes 
demux audio to mux and HDMI outputs, and AES audio to AES and analog outputs.

Figure 3-21 on page 54 shows the audio routing in the X50. 

The AES Present, Analog Present, and DMX Channel Present read-only parameters 
display the status of the incoming audio feeds. When you select these parameters, each of 
the eight channels is displayed as a symbol. 

The AES Present parameter has a unique feature that notifies you when an AES signal is 
available for that channel (visible as a P symbol on the channel), but the channel has been 
set to an analog input.

See Figure 3-20 on page 52 for an explanation of these symbols.

Note: The analog audio output of the X50 is always low-impedance. To ensure that you do 
not overload the audio output, always connect to high impedance downstream.

Figure 3-20  Audio Status Parameters

Audio 
Metadata

The audio metadata feature de-embeds audio metadata from various sources and then 
re-embeds the audio metadata into multiple outputs.

The audio metadata source may be one of the following:

 Metadata embedded in SDI (Methods A and B)

 Input of the serial port

 Metadata generator

 AAP 1 Dolby E Decoder Output (when a Dolby E decoder is configured in AAP 1)

 AAP 2 Dolby E Decoder Output (when a Dolby E decoder is configured in AAP 2)

DMX Present =  =  A  A  D  D =  =

No signal 
present

Audio present

Data 
present

No signal 
present

Analog Present =  =  =  =  =  =  A  A

AES Present =  =  A  A  D  D  P  P

No signal 
present

Data 
present

Audio present 
(but not selected)

Audio 
present

Analog audio 
present
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The audio metadata may be inserted into the following outputs:

 SDI 1 and SDI 2 (Methods A and B)

 Serial port

Once the source is selected, it applies to all of the outputs.

Dolby E
Alignment

It is important to maintain a proper timing relationship between the Dolby E header and the 
first line of video especially when recording video with embedded audio on tape transports. 
This is commonly known as the guard band. On the X50, the Dolby E alignment timing is 
determined by the value of the SDI 1 or SDI 2 Dolby E Start Line embedder controls. 

To use this feature, first enable the auto alignment (Audio > Other > Dolby E Auto Align), 
and then make your start line settings at Audio > Embedder > SDI 1 or SDI 2 Dolby E 
Start Line.
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Figure 3-21.  X50 Audio Routing
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Logo Generator
The X50 logo generator and inserter provides on-demand insertion of pre-defined static 
SD-SDI and HD-SDI logo images.

Logos used by the X50 must be created or saved in the .mg2 file format, and initially stored 
on an SD card at your PC workstation. Then you must insert the card into the slot located in 
the front of the X50 frame. Logos that you insert into the video feed appear on the SDI 1 
primary output.

LogoCreator software that you will need to convert the files to the .mg2 format can be 
downloaded from our website as part of the Icon Soft Tools package.

Figure 3-22  Progression of Logo to On-Air Signal

The files that you use as logos must be selected according to the video output standard set 
on the X50 SDI1 Output format. When the output standard changes on the module, the 
X50 automatically loads files that use the selected output standard.

The following SD cards are supported by the logo generator:

 SanDisk 1 GB and 2GB SD class 2

 SanDIsk 4GB SD class 4

 SanDisk 4GB SDHC class 10

 Kingston 1 GB and 2GB SD class 2

 Kingston 4GB SD class 4

New SD cards must be formatted to the FAT standard in a PC before use. Be sure to create a 
Logos folder and a Presets folder before you start.

Basic Steps to Installing Logo Files
If you are starting with existing graphics files, these basic steps are described in the 
following pages:

1 Install the LogoCreator conversion software.

2 Convert the logos to a .mg2 format.

3 Transfer the files to the SD card directly from the PC, and then insert the card into the X50.

4 Power cycle the X50 by following System Setup > Soft Reboot.

5 Set the parameters and load the logo.

Logo Insertion on the X50
Existing logo 
graphic with 

alpha channel

Conversion to 
.mg2 format using 

LogoCreator

Storage of 
logo file on an 

SD card 

Loading of file 
into X50 module 

for on-air use
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Step 1: Install LogoCreator Software
All logos used by the X50 must either be generated as .mg2 files, or converted to that 
format. LogoCreator software is contained in the Icon Soft Tools package, found on our 
website.

For best results, LogoCreator requires a PC with the following system specifications:

 Intel Pentium III processor at 500 MHz or faster

 512 MB or more of physical memory (RAM)

 Microsoft® Windows® XP or Windows 2000

If a version of LogoCreator already exists on the PC, ensure that you first uninstall the 
program and restart the computer. Then proceed with the steps below:

1 Close all other software applications running on the PC and then insert the IconTools 
CD-ROM into the computer’s CD-ROM tray.

2 Using Windows Explorer, browse to the CD-ROM contents, and then double-click the 
LogoCreator folder.

3 Double-click Setup.exe. 

4 When the IconTools 3 Setup box appears, click Next, and then follow the on-screen 
installation instructions. 

Step 2: Convert Files to the .mg2 Format
Using LogoCreator, you need a source image file for the fill portion of your logo, and a 
source image file for the key portion. The fill is the picture or image you want to overlay 
onto the program output. The key is the cutout or shape of the desired logo, which may or 
may not be the same shape as the fill. Using LogoCreator, you will set the fill and key 
images to the same size (resolution) as the standard of the X50 output. LogoCreator infers 
the key from the alpha channel in a targa (.tga) file.

After you save the logo, the logo displays in your LogoCreator workspace. To save your logo 
files using LogoCreator, follow these steps:

1 In LogoCreator, select the Video Standard from the Menu bar.

Note: When 720p or 1080p is required, use the 1080i option in Video Standard to 
provide the best loading time. Ensure that you create 720p and 1080p graphics in full 
screen, with the logo already positioned correctly beforehand. Although the logo may not 
appear in the safe area in LogoCreator, it will be correctly placed in the final video output.

2 Open the Logo Set-Up dialog box (Figure 3-23 below).

When you first open LogoCreator, the Logo Set-Up dialog box opens automatically. If the 
Logo Set-Up dialog box is closed, select File > New to open the dialog box.
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Figure 3-23  LogoCreator Setup Dialog Box

Note: If you click the Open button directly in the Logo Set-Up box, the program will only 
launch files with a .mg2 prefix. If you attempt to open a file with any other prefix, the 
program will generate error messages.

3 Click the Logo button to open the Static Logo dialog box.

4 Use the Logo ID box to assign the logo to a specific slot on your IconLogo system. 

5 Enter a name for the logo in the Name box.

6 Click the Open button below the Logo Image Preview window. 

The Open dialog box displays.

7 Select your existing logo file and click the Open button to open the logo in the Static Logo 
dialog box.

Figure 3-24  Static Logo Dialog Box

 A preview of the composited logo displays in the Logo Image Preview area.

 A preview of the image alpha displays in the Logo Alpha Preview area if the file 
contains alpha.

8 Select a file to use as the alpha channel for your logo. 

You must select a file before you can save the logo.
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 To use the original image’s alpha channel, select the Use the alpha key found with 
image check box.

 To use a different image for the alpha channel, clear the Use the alpha key found 
with image check box, and then click the Open button to select a new file for your 
alpha channel.

Note: An alpha channel is an 8-bit layer in a graphics file format that is used for expressing 
translucency (transparency). Typically, you define the alpha channel on a per-object basis. 
Different parts of an object will have different levels of transparency depending on how 
much background you want to show through.

9 Click the Save button in the Static Logo dialog box. 

The Save Logo File dialog box opens where you can save your logo as a .mg2 file. Once 
you save the logo as a .mg2 file, the logo displays in the LogoCreator workspace.

Figure 3-25  LogoCreator Work Space

Once you create a .mg2 logo you can open the file in LogoCreator, set the logo position, 
and modify specific logo attributes. LogoCreator also makes it possible to adjust the noise 
and strength of the key signal and apply fade on/off transitions to the logo.

Opening and Previewing an Existing .mg2 Logo
To make position, opacity, or key level changes to the .mg2 logo, follow these steps:

1 In LogoCreator, select File > Open to open the Open Logo File dialog box, or if the Open 
Logo File dialog box has already launched, click Open.

2 Using the Open Logo File dialog box, find and select your .mg2 logo file.

3 Click the Open button. 

The .mg2 logo displays in the LogoCreator workspace.
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In the upper left corner (Figure 3-27), you can preview the changes you make using the 
Fill, Opacity, and Logo Position options. (Other functions shown in the window are not 
supported on the X50.)

Figure 3-26  Opening a Logo

Figure 3-27  Preview Pane
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Modifying the Position, Opacity, and Key Level
Using the Modify button, you can adjust the logo attributes you defined when you created 
the logo (you can also make these settings using the X50 controls at Video > Logo).

1 Click the Modify button to open the Logo dialog box, where you defined the logo 
attributes.

2 Use the options to adjust the logo properties.

3 Click Save to save the changes and return to the LogoCreator workspace.

Figure 3-28  Positioning a Logo

To position your logo, either drag the logo to a new position, or use the Logo Position X 
and Logo Position Y boxes below the workspace to place your logo in an exact position. 
You can enter positive or negative values. The X value moves the logo horizontally and the 
Y value moves the logo vertically by the set number of pixels. 

The Opacity sets the overall transparency level for the composited logo. Use either the 
Opacity field or slider to adjust the logo transparency. 100% sets the logo as completely 
opaque. 0% sets the logo as completely transparent.

Drag

or change position 
values
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Step 3: Transfer the Logos to the SD Card, and to the X50
When your logos have been created or converted to the .mg2 format, save them to your 
computer hard drive before saving them to the SD card. On the SD card, create a folder 
named Logos and store the logo files inside that folder. Then insert the card into the slot 
located on the left side of the X50. 

Step 4: Set the Parameters and Load the Logo Files
Using the X50, you can preset a logo filename and its settings for each output standard. 
The preset logo will automatically load when the corresponding output standard is selected 
and becomes the active SDI1 Output format. You must correctly set the Select Raster 
parameter (Video > Advanced Logo) to edit the logo preset configuration for a specific 
output standard.

If you have selected a logo that matches the output standard and the logo is available for 
use, the Load Status parameter (under Video > Logo) will read Loaded. Select Logo 
Enable to activate the logo.

GPI and Rules Engine

GPI
The X50 has four separate GPI inputs and four separate GPI outputs (found at System 
Setup > GPI). In certain operation modes, some events are not applicable. In these cases, a 
GPI trigger leads to no action.The GPIs are open collector style, with approximately 10 K 
pull-ups to +5V. In other words, you can use contact closure-to-ground switches to control 
these GPI inputs.

All GPI related parameters can be found under Control > GPI.

Each GPI pin can be individually set to either input or output status; thus there are eight 
controls in total (parameters GPI 0 Direction to GPI 7 Direction), located at GPI and Rules 
Engine > GPI > GPI Direction.

GPI inputs make it possible to enable a test signal, insert a logo, control the ARC being used 
for a particular conversion mode, trigger SCTE-104 or BT-1685 data, and as well, insert the 
AFD, WSS or VI code. 

GPI outputs can reflect the state of the current input video LOV status—whether the test 
signal is enabled, aspect ratio is used, or can be triggered on a specific input AFD, WSS or VI 
code. 

Table 3-4  Typical Card-to-X50 Logo Loading Times

Content Format Approximate Load Time 
from Card to X50

Bug logo, 1/16 screen 720p 8 seconds

Detailed 500 kB image, 
1/4 screen

720p 2 minutes

Full screen, 8 Mb 1080p 6 minutes
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The read-only parameters GPI Input Level Status and GPI Output Level Status display 
current GPI pin level information. From left to right, the symbols indicate the level status of 
GPI pins 0 to 7. A value of 1 represents a high, 0 represents a low, and a - symbol 
represents Not Valid—which means the pin is assigned to the opposite direction. A * 
symbol shows the pin is constantly driving (output) or is driven (input) by SCTE-104 or 
BT-1685 data.

Rules Engine
When the X100 is in operation, signals often change, input video standards shift, and 
incoming audio channels may be altered. You can predict many such changes, and have the 
X100 respond accordingly. Script-based rules engine provide the flexibility to pre-edit the 
conditions to be monitored, and automatically make the necessary setting changes.

In summary:

 Rules Engines involve conditions and actions. 

 Parameter Control Scripts use parameter status conditions to drive parameter controls. 

 Custom GPI Input Scripts use GPI input status conditions to drive parameter controls. 

 Custom GPI Output Scripts use parameter status conditions to drive GPI output values.

Custom GPI Input Script
To enable a custom GPI input script, set the direction of the specific pin in the GPI Input To 
Edit parameter (GPI and Rules Engine > GPI > GPI Input) and then set the Event 
parameter to Custom GPI Input Script. Enter your script into the GPI Input Script (Part I) 
field. The parameter allows a maximum of 251 characters to be entered. If additional script 
space is needed, use the Custom Input Script (Part II to IV) parameter. GPI Input Script 
Status reports the parsing and active status of the script. If a syntax error is detected when 
a new script is entered, this parameter will report Error: x message. The variable x is an 
index number starting from the beginning of the script to indicate around which character 
the script parser first encounters a syntax error. Custom GPI Input Level Status displays 
current custom GPI input pin level information. From left to right, the symbols indicate the 
level status of GPI ping 0 to 7, where 1 represents a high, 0 represents a low, and - 
represents Not Valid—which means the pin is assigned to the output direction, or assigned 
to an event that is not a custom GPI input script.

GPI input scripts are made up of one or multiple statements. Each statement consists of one 
condition and one or multiple assignments. During device operation, if the condition in a 
statement becomes true, the assignment in the statement will take effect. 

<script> ::= <statement> { <statement> } 

<statement> ::= IF <condition> THEN <assignment> { <assignment> }

<condition> ::= <comparison> { <logic op> <comparison> }

<comparison> ::= GPIx <comparison op> y

Where x is in the range of [0, 7], y could be 0 or 1

<assignment> ::= PARAM[x] = y
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Where x is the CCSP ID of a device parameter, y is a value for that parameter. At this time, 
only integer and enum type of parameter assignments are supported. String type parameter 
assignment is not supported.

<comparison op> ::= == | > | < | >= | <= | !=

<logic op> ::= && | ||

Comparisons can be ANDed together using &&, and then can be ORed together using ||. 
The AND operation always has precedence over the OR operation when AND and OR both 
exist in a condition.

Custom GPI Output Script
To enable a custom GPI output script, set the direction of the specific pin in the select GPI 
Output To Edit parameter (GPI and Rules Engine > GPI > GPI Output) and then set the 
Event parameter to Custom GPI Output Script.

Enter your script into the GPI Output Script (Part I) field. The parameter allows a 
maximum of 251 characters to be entered. If additional script space is needed, use the 
Custom Output Script (Part II to IV) parameter. GPI Output Script Status reports the 
parsing and active status of the script. If a syntax error is detected when a new script is 
entered, this parameter will report Error: x message. The variable x is an index number 
starting from the beginning of the script to indicate around which character the script 
parser first encounters a syntax error. Custom GPI Output Level Status displays current 
custom GPI output pin level information. From left to right, the symbols indicate the level 
status of GPI ping 0 to 7, with 1 representing a high, 0 representing a low, and - 
representing Not Valid—which means the pin is assigned to the input direction, or 
assigned to an event that's not custom GPI output script.

GPI output scripts are made up of one or multiple statements. Each statement consists of 
one condition and one or multiple assignments. During device operation, if the condition in 
a statement becomes true, the assignments in the statement will take effect. 

<script> ::= <statement> { <statement> } 

<statement> ::= IF <condition> THEN <assignment> { <assignment> }

<condition> ::= <comparison> { <logic op> <comparison> }

<comparison> ::= PARAM[x] <comparison op> y 

Where x is the CCSP ID of a device parameter, y is a value for that parameter. The device 
parameter could be one of three types: integer, enum, string. Depending on the parameter 
type, y could take different format:

“Integer: y is integer value of the parameter

“Enum: y is the enum value index inside the enum

“String: y is in a 'zzzz' string format, where z is a character. Special character * can be 
used as wild card. AA* and AABB will be considered as equal

<assignment> ::= GPOx = y

Where x is in the range of [0, 7], y could be 0 or 1
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<comparison op> ::= == | > | < | >= | <= | !=

<logic op> ::= && | ||

Comparisons can be ANDed together using &&, and then can be ORed together using ||. 
The AND operation always has precedence over the OR operation when AND and OR both 
exist in a condition.

Parameter Control Script
To use a Parameter Control Script, select Enable in the Activate Script parameter 
(System Setup > Parameter Control Script). Then create your content in Script (Part I) 
to change a parameter value based on some other parameters' value. If there is additional 
script necessary, use the Script (Part II to IV) parameters.

Script Status [RO] reports the parsing and active status of your custom input script.

The X50 make it possible for you to write user scripts for custom signal flow management, 
so that you can dynamically change selected parameters when a signal flow changes. This 
addresses the need for managing input video and audio signals that constantly change. In a 
typical scenario, a preset is recalled by an operator, or the operator determines what is at 
the input and then sets up the device to process the video and audio essence, data and 
metadata. This is known as “user-scripted signal flow management” or a “rules engine.”

Example
Some broadcasters have compliance issues that need to be addressed by specialized signal 
processing.

A common problem is the replacement of a mono audio channel dedicated to audio 
content for the visually-impaired, if the channel is absent. Service for the visually-impaired is 
required in Canada, and available soon in the United States and elsewhere. In Europe, this 
service is known as the Audio Description. In North America, it is known as Descriptive 
Video, DVS Descriptive Video Service, or Video Description. 

When this mono audio channel is present at the input, the requirement is to pass it through 
to the output and into the Secondary Audio Program (SAP) channel. However, if the signal 
is absent, the X50 can detect the problem and perform one of the following through 
scripts:

 Sum and route the signal to the output channel feeding the SAP, if stereo audio is 
present (one PCM)

 Downmix to 2.0, then sum and route to the output channel feeding the SAP, if 
surround sound is present (three PCMs)

 Decode the audio, downmix to stereo, sum to mono, and then route to the output 
channel that feeds the SAP, if Dolby Digital or Dolby E is present (one non-PCM)

Note: In the above example, as audio channels change, the audio V-fades must be enabled 
by setting the Fade Time to a non-zero value. This setting will prevent clinks or pops from 
occurring downstream.
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Enabling the Parameter Control Script
To enable a parameter control script, set the Activate Script parameter to Enable. Enter 
your script into the Script (Part I) parameter (maximum 251 characters). If additional script 
space is needed, use the Script (Part II to IV) parameters.

Script Status [RO] reports the parsing and active status of the script. If a syntax error is 
detected when a new script is entered, this parameter will report Error: x message (x is an 
index number starting from the beginning of the script to indicate around which character 
the script parser first encounters a syntax error).

Writing the Parameter Control Script
Parameter control scripts are made up of one or multiple statements. Each statement 
consists of one condition and one or multiple assignments. During device operation, if the 
condition in a statement becomes true, the assignment in the statement will take effect.

<script> ::= <statement> { <statement> }

<statement> ::= IF <condition> THEN <assignment> { <assignment> }

<condition> ::= <comparison> { <logic op> <comparison> }

<comparison> ::= PARAM[x] <comparison op> y 

Where x is the CCSP ID of a device parameter, y is a value for that parameter. The 
device parameter could be one of three types: integer, enum, string. Depending on the 
parameter type, y could take different format:

 Integer: y is integer value of the parameter

 Enum: y is the enum value index inside the enum

 String: y is in a 'zzzz' string format, where z is a character. Special character '*' can 
be used as wild card. 'AA*' and 'AABB' will be considered as equal

<comparison op> ::=  == | > | < | >= | <= | !=

For string type of parameter, only == and != operators are supported.

<assignment> ::= PARAM[x] = y

Where x is the CCSP ID of a device parameter, y is a value for that parameter.

<logic op> ::= && | ||

Comparisons can be ANDed together using &&, and then can be ORed together using 
||. The AND operation always has precedence over the OR operation when AND and 
OR both exist in a condition.

The following script condition

PARAM[400]==5 || PARAM[400]==3 || PARAM[400] >= 8 && PARAM[400] <= 12

should be interpreted as 

PARAM[400]==5 || PARAM[400]==3 || (PARAM[400] >= 8 && PARAM[400] <= 12)
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Script example:

IF PARAM[754]==2 THEN PARAM[755]=2

IF PARAM[754]==3 THEN PARAM[755]=3

IF PARAM[754]==7 THEN PARAM[755]=10

IF PARAM[754]<2 || PARAM[754] > 3 && PARAM[754]<7 THEN PARAM[755]=19 

IF PARAM[733]=='AAAA AAAA AAAA AAAA' THEN PARAM[26]=4

Note: Currently, a maximum of 30 statements is allowed in a script. A maximum of 40 
assignments is allowed in a statement.
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4 Advanced Audio Processing
Overview To use Advanced Audio Processing options, you will need to purchase the 
X50OPT-ADVAUD audio submodule, and a number of Software Key License Credits (see 
Table 4-1 for the available licenses). The number of license credits that you need depends 
on which audio functions you select for DTS Neural, Dolby Digital (AC-3) Decoder, Dolby 
Digital (AC-3) Encoder, Dolby E Decoder, or Dolby E Encoder.

The DTS Neural UpMix mode, for example, requires three license credits, while the 
MultiMerge mode requires four. These credits are transferable across different DTS Neural 
options, and can be used for any combination of DTS Neural Loudness Control, or DTS 
Neural Surround UpMix, DownMix, and MultiMerge. However, they can only be used in 
the X50 for which they were purchased.

Table 4-1  Advanced Audio Processing Modes, Latency, and Credit Cost 

Mode Latency Credit Cost

M1: UpMix (low/high latency) 26.86 ms (low) / 48.19 ms (high) 3 DTS

M2: DownMix 10.86 ms 3 DTS

M3: MultiMerge (low/high latency) 26.86 ms (low) / 48.19 ms (high) 4 DTS

M4: Loudness Control 2.0 58.86 ms 1 DTS

M5: Loudness Control 5.1 58.86 ms 3 DTS

M6: Loudness Control 4x2.0 58.86 ms 4 DTS

M7: Dolby Digital Decode with Downmix 33.25 ms 1 DDD

M8: Dolby E Decode 2 frames 1 DED

M9: Dolby E/Digital Decode with Downmix 2 frames (E or Digital) 1 DED, 1 DDD

M10: Dolby Digital Encode 69.43 ms 1 DDE

M11: Dolby E Encode 1.13 frames 1 DEE

M12: MultiMerge, Loudness Control 
(low/high latency)

74.86 ms (low) / 96.19 ms (high) 8 DTS

M13: UpMix, Loudness Control 
(low/high latency)

74.86 ms (low) / 96.19 ms (high) 4 DTS

M14: DownMix, Loudness Control 58.86 ms 4 DTS

M15: Loudness Control 5.1+2.0 58.86 ms 4 DTS

M16: Loudness Control 2x1.0 58.86 ms 1 DTS
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Installing the X50OPT-ADVAUD Audio Submodule

To use the Advanced Audio Processing features, the X50OPT-ADVAUD audio submodule 
must first be installed.

See page 108 for details.

Enabling DTS Neural and Dolby Modes
Follow these steps to enable the DTS Neural and Dolby Modes:

1Navigate to Audio > Advanced Audio Processing > AAP 1 or AAP 2 Configuration > 
General menu. 

1 Set the Processing Mode to one of the advanced audio modes shown in Table 4-1.

2 Configure the routing in the Audio > Routing > AAP Input Select and Audio > Routing 
menus. 

Note: You must select the AAP mode first (M1, M2, M3, etc.) before configuring the 
routing; the AAP mode you select may change the routing settings

2In the drop down box at the top of the column, change your selection from General to the 
mode you selected in step 3.

3Wait several seconds for the fields to refresh.

4Configure the parameters that are available in your mode (parameters that are not applicable 
are grayed out).

Once you have selected your DTS Neural modes, the Selection Status parameter 
(AAP x > General) displays one of the following:

 Good

 Not Enough License Credit

5From the main section of the Advanced Audio Processing (AAP) block, (select AAP x Input 
Routing and then select your audio sources.

6In the Audio Output Routing block, select the destinations for your audio.

M17: Loudness Control + Dolby Digital Encode 5.1 125.43 ms 1 DDE, 3 DTS

M18: Loudness Control + Dolby E Encode 5.1+2.0 3.13 frames 1 DEE, 4 DTS

M19: Loudness Control + Dolby E Encode 4x2.0 3.13 frames 1 DEE, 4 DTS

M20: DD Decode + MultiMerge (low/high latency) 82.58 ms (low) / 103.91 ms (high) 1 DDD, 4 DTS

M21: DE Decode + MultiMerge (low/high latency) 2 frames + 16 ms (low) / 2 frames + 
37.33 ms (high)

1 DED, 4 DTS

M22: DE/DD Decode + MultiMerge (low/high latency) 2 frames + 16 ms (low) / 2 frames + 
37.33 ms (high)

1 DDD, 1 DED, 4 
DTS

Table 4-1  Advanced Audio Processing Modes, Latency, and Credit Cost (Continued)

Mode Latency Credit Cost
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Dolby Products
Figure 4-1 and Figure 4-2 show how Dolby is used in typical X50 applications. Dolby 
Digital (AC-3) and Dolby E decoding takes place at ingest for voice-over. The Dolby LED on 
the front panel illuminates when an AAP is configured as a Dolby E or Dolby Digital encoder, 
and the encoder is currently operating.

Figure 4-1.  Dolby Digital Block Diagrams
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Figure 4-2.  Dolby E Block Diagrams
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AAP Internal Metadata

Dolby Digital 
When using Dolby Digital encoding, if you select AAP Internal metadata generator as the 
Metadata Source one program is available (the Metadata Index parameter is disabled). 
However, all other metadata sources have up to eight programs available. Use the 
Metadata Index parameter to select the program you wish to encode. 

Dolby E
Using Dolby E encoding, up to eight metadata programs may be encoded, depending on 
the setting of the Program Configuration parameter. For example, if you set Program 
Configuration to 5.1+2, two sets of metadata are encoded (one for 5.1, one for 2). If 
Program Configuration is set to 8x1, eight sets of metadata are encoded. To configure 
the metadata settings for each program, navigate to the AAP Internal Metadata menu 
and select the desired program from the Program Select parameter. Then configure the 
metadata settings as required.

Note: Dolby E is always in sync with the frame rate of the video. To ensure downstream 
decoders work correctly, you must make the correct settings in Dolby E Sync Select 
(default is Processing Ch 1 Output).

Dolby Audio Metadata
When you apply external metadata to the X50, the metadata properties persist even after 
you remove the external metadata from the module. Performing a Factory Default of the 
user settings does not clear the metadata properties that were received when external 
metadata was present. After you remove the external metadata, you must restart the 
module to clear the metadata properties.

For general information about the use of audio metadata in professional video applications, 
visit the Dolby Web site at www.dolby.com.

Dual-Input Dolby Decoder
The dual-input Dolby Decoder feature is available for all of the Dolby Decoder modes. Once 
an AAP is configured in one of the Dolby decoder modes, the Dual-Input function can be 
activated in the menu (AAP-X Input Routing > AAP-X Dolby Source Select) by selecting 
the appropriate source into AAP-X Secondary Dolby Source Select (the default is None).

This feature is useful for cases where a PCM program is available on one audio pair and a 
Dolby program is available on a different audio pair. In such cases, the PCM pair needs to be 
routed into the primary input, and the Dolby pair into the secondary input. The decoder will 
automatically switch to PCM bypass (from the primary input) whenever the Dolby stream 
stops.

Ensure that you check the read-only Bitstream Format parameter in the Dolby Decoder 
menu (within the AAP block) to determine whether PCM input (Non-Dolby) or one of the 
Dolby inputs is being processed.

Table 4-2 illustrates the behavior of the decoder. See the additional notes at the bottom of 
the table.
  

http://dolby.com
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Table 4-2  Decoder Behavior 

Mode Input #1 Input #2 Output Notes

[M7]
DD
Decoder

PCM - PCM

AC3 - DEC

DE - MUTE

PCM PCM PCM #1

PCM AC3 DEC #2

PCM DE PCM #1

AC3 PCM DEC #1

DE PCM MUTE

AC3 AC3 DEC #? Undetermined: one of the streams 
gets decoded

AC3 DE DEC #1 Undetermined: DEC #1 or MUTE

DE DE MUTE

DE AC3 DEC #2 Undetermined: DEC #2 or MUTE

[M8]
DE
Decoder

PCM - PCM

AC3 - MUTE

DE - DEC

PCM PCM PCM #1

PCM AC3 PCM #1

PCM DE DEC #2

AC3 PCM MUTE

DE PCM DEC #1

AC3 AC3 MUTE

AC3 DE DEC #2 Undetermined: DEC #2 or MUTE

DE DE DEC #? Undetermined: one of the streams 
gets decoded

DE AC3 DEC #1 Undetermined: DEC #1 or MUTE
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The following important notes apply to the operation of the Dual-Input Dolby Decoder 
feature:

 The Dual-Input feature is available for all Dolby Decoder modes.

 In Dual-Input mode, inputs may come only from the same audio de-embedder.

 In Dual-Input mode, the secondary input is dedicated for Dolby-only streams.

 Based on its intended use, in Dual-Input mode the primary input is normally PCM.

 In Dual-Input mode, combinations where both inputs are Dolby should be avoided.

When an AAP is configured as a Dolby E encoder and is routed to an embedded output (or 
Dolby E from de-embedded or AES inputs is routed to an embedded output), the X50 will 
ensure the Dolby E header is aligned with the line specified by the SDI 1/2 Dolby E Start 
Line parameter. If audio output delay is then added to the embedded output pair 
containing Dolby E, the X50 will compensate by adding additional audio delay to ensure the 
Dolby E header is once again aligned. This additional delay could be up to one frame, 
depending on how much output audio delay is added.

The X50 aligns output audio/video timing between SDI 1 and SDI 2, as well as the AES and 
analog audio outputs. If an audio output is routed from an AAP, the X50 automatically 
compensates for the latency introduced by the AAP. If the AAP mode is changed, there will 
be a momentary audio disturbance in all audio outputs as the X50 realigns all audio/video 
outputs to compensate for the changed AAP latency.

[M9]
DD/DE
Decoder

PCM - PCM

AC3 - DEC

DE - DEC

PCM PCM PCM #1

PCM AC3 DEC #2

PCM DE DEC #2

AC3 PCM DEC #1

DE PCM DEC #1

AC3 AC3 DEC #? Undetermined: one of the streams 
gets decoded

AC3 DE DEC #? Undetermined: the DE stream may get 
decoded

DE DE DEC #? Undetermined: one of the streams 
gets decoded

DE AC3 DEC #? Undetermined: the DE stream may get 
decoded

Notes:
1. PCM = PCM audio or mute
2. AC3 = Dolby Digital stream
3. DE = Dolby-E stream
4. Avoid combinations shown with a gray background in this table. The decoder searches both input streams and 
locks to the first stream detected; the search order is input #1, then input #2. As such, the output depends on 
the alignment of the two input streams relative to each other.

Table 4-2  Decoder Behavior (Continued)

Mode Input #1 Input #2 Output Notes
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DTS Neural Products
The block diagrams shown in Figure 4-3 to Figure 4-5 illustrate the uses of the different 
DTS Neural Software Key License Credits. 

Figure 4-3.  Block Diagrams for Single DTS Neural Audio Options 
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Figure 4-4.  Block Diagram for Multiple DTS Neural Options
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Figure 4-5.  Block Diagrams for Multiple DTS Neural Options
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DTS Neural Surround Audio UpMix 

Overview
The DTS Neural Surround UpMix renders any two channel audio source (stereo, matrix 
encoded stereo, LtRt, or DTS Neural Surround LwRw) as surround sound. The DTS Neural 
Surround UpMix can simultaneously position individual elements within the surround field, 
creating high levels of image stability and granularity. The UpMix technology avoids taking 
“artistic license” with content by placing audio exactly where it would be heard in a 
professional LEDE (Live End Dead End) listening environment. For example, mono or 
pan-pot stereo will image in front of the listener, whereas stereo containing depth 
information will surround the listener. You can use the DTS Neural Surround UpMix as a 
stand-alone unit to monitor stereo production, or you can use it in tandem with the DTS 
Neural Surround DownMix as a complete 5.1 transport solution. Figure 5 below shows an 
UpMix taking a two-channel audio source (stereo, matrix encoded stereo, LtRt or DTS 
Neural Surround LwRw) and rendering a 5.1 multi-channel mix. 

Figure 5.  UpMix Block Diagram 

Table 4-3  Channel Configurations for DTS Neural UpMix

Input 
Routing Channel Name 2.1 3.1 4.1 5.1 6.1 7.1 Phantom 

6.1
Phantom 
7.1

1 Left (L) Yes Yes Yes Yes Yes Yes Yes Yes

2 Right (R) Yes Yes Yes Yes Yes Yes Yes Yes

3 Center (C) Mute Yes Mute Yes Yes Yes Mute Mute

4 Low Frequency 
Effects (LFE)

Yes Yes Yes Yes Yes Yes Yes Yes

5 Left Surround (Ls) Mute Mute Yes Yes Yes Yes Yes Yes

6 Right Surround (Rs) Mute Mute Yes Yes Yes Yes Yes Yes

7 Left Back (LB) or 
Center Back (CB)

Mute Mute Mute Mute Yes 
(CB)

Yes 
(LB)

Yes Yes

8 Right Back (RB) Mute Mute Mute Mute Mute Yes Mute Yes
  



Chapter 4
Advanced Audio Processing

78

  
Table 4-4  DTS Neural Surround Audio UpMix Parameters 

Parameter Name Function Options

UpMix Status Indicates the state of the AAP mode  Uninitialized

 Running

 Not Running 
(bypassed)

 Not Running 

Channel Config Controls the output channel configuration  2.1

 3.1

 4.1

 5.1

 6.1

 7.1 

 Phantom 6.1

 Phantom 7.1

Latency Specifies the latency profile of the up-mix  Low

 High 

DICE Processing Level Specifies the amount of DICE processing to perform 0 to 100

Depth Specifies the amount of front-to-back bias to apply to the 
standard soundstage

-100 to 100 (0)

Front Width Specifies the amount of narrowing or widening to perform 
on the front channels

-100 to 100 (0)

Surround Width Specifies the wideness of the surround channels -100 to 0 (0)

LFE Cutoff Specifies the low-pass cutoff frequency of the LFE channel 
(0 specifies no LFE channel)

 0 Hz

 60 Hz

 80 Hz

 100 Hz

 120 Hz

 140 Hz 

Final Limiter Ceiling Specifies the threshold where final limiting on the 
up-mixed output occurs

 -12 to 0 
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DTS Neural Surround Audio DownMix 

Overview
The DTS Neural Surround DownMix enables 5.1 surround sound to be transported through 
any stereo infrastructure. The DownMix process is based upon the principle that both 
natural stereo and 5.1 content are two-dimensional; both contain width and depth spatial 
attributes. 

The DTS Neural Surround DownMix can represent six channels of discreet audio sources in a 
stereo DownMix by transforming the sources into pure intensity and coherence encoding. 
By correcting overlaps of the signal sources in intensity, time, coherence, polarity, and phase 
before the six channels are combined, the DTS Neural Surround DownMix accounts for the 
problems suffered in traditional matrix encode systems—such as comb filtering, spatial 
location distortion, etc. 

The proprietary DTS Neural Audio “watermark process” faithfully reproduces surround 
information when it is rendered by the DTS Neural Surround UpMix or any LtRt system. In 
brief, the DTS Neural Surround DownMix produces a stereo DownMix that accurately 
represents the original content whether monitored in mono, stereo, matrix or DTS Neural 
5.1 Surround Sound. 

Figure 6 below shows a DownMix taking a multi-channel audio source. The DownMix 
creates two-channel audio source using the DTS Neural Audio approach of embedding a 
watermark signal within the stereo audio signal patch. The watermark signal contains 
spatial and steering positioning information. The resulting stereo audio signal is also known 
as LwRw. 

Figure 6.  DownMix Block Diagram 

Table 4-5  DTS Neural Surround Audio DownMix Parameters 

Parameter Name Function Options

DownMix Status Indicates the state of the AAP mode  Uninitialized

 Running

 Not Running 
(bypassed)

 Not Running 

Channel Config Controls the input channel configuration  5.1

 7.1 

L/R Encoding Mode Specifies the encoding mode for the left and right channels  Phantom Center

 Hard Center 
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Parameter Name Function Options

LFE Cutoff Specifies the low-pass cutoff frequency of the LFE channel (0 
specifies no LFE channel)

 0 Hz

 60 Hz

 80 Hz

 100 Hz

 120 Hz

 140 Hz 

Final Limiter Ceiling Specifies the threshold where final limiting on the down-mixed 
output occurs (0 indicates no final limiting)

 -20 dB to 0 dB 

 Active Correction Specifies correction to the DownMix ICLD, ICPD and spectrum  Off

 On 

Table 4-5  DTS Neural Surround Audio DownMix Parameters (Continued)
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DTS Neural Surround Audio MultiMerge 

Overview
The DTS Neural Surround MultiMerge enables broadcasters to transition from stereo to 5.1 
surround sound, providing viewers with a 24/7 surround sound experience. With 
MultiMerge in line, 5.1 original content is passed unaffected to the viewer while original 
stereo content is UpMixed to a 5.1 surround sound image. This provides the viewer with a 
consistent surround experience. 

The transition between 5.1 and stereo occurs seamlessly without the need of operator 
intervention. By offering a 24/7 5.1 signal, AC3 metadata does not transition between 2/0 
and 3/2 mode. This prevents audio clicks, pops, and dropouts. The process also avoids 
taking “artistic license” with content by placing audio exactly where it would be heard in a 
professional LEDE (Live End Dead End) listening environment. For example, mono or 
pan-pot stereo will image in front of the listener, whereas stereo containing depth 
information, or LtRt encoding, will surround the listener. 

You can use the MultiMerge in combination with the DTS Neural Surround DownMix device 
to pass 5.1 through stereo-only facilities and therefore eliminate the need for costly master 
control upgrades.

Figure 7 shows how the MultiMerge takes a two-channel audio source (stereo, matrix 
encoded stereo, LtRt or DTS Neural Surround LwRw) and render a 5.1 multi-channel mix; in 
combination with taking original multi-channel content and creating a stereo DownMixed 
signal, depending on the input configuration and content source used.

Figure 7.  MultiMerge Block Diagram 
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Table 4-6  DTS Neural Surround Audio MultiMerge Parameters 

Parameter Name Function Options

MultiMerge Status Indicates the state of the AAP mode  Uninitialized

 Running

 Not Running (bypassed)

 Not Running 

Input Selection Mode Specifies how input channels are selected.  Mix

 Multi

 Stereo

 Aux

 Multi Detect

 Stereo Detect

 Aux Detect

 Multi Aux Stereo 

Detected Input [RO] Reports the current inputs that are included in the 
output

 Unknown

 Mix

 Multi

 Stereo 

Input Noise Floor 
Threshold

Specifies the amount of signal required when 
detecting active inputs

 -80 dB to -50 dB (-60 dB)

Input Crossfade Time Specifies the transition time between inputs when 
switching due to detected level changes

50 ms to 750 ms (200 ms)

MultiMerge Mode The operation mode for MultiMerge  Auto

 Pass Through

 Up Mix 

Latency Specifies the latency profile of the MultiMerge  Low

 High

Noise Floor Threshold Specifies the signal level that must be detected on 
any of the C, LFE, Ls or Rs for the content to be 
considered surround

 -80 dB to -50 dB (-60 dB)

Crossfade Time Specifies the transition time between up-mix and 
passthrough when in auto mode

50 ms to 750 ms (200 ms)

Upmix Depth Specifies the amount of front-to-back bias to apply 
to the standard soundstage

-100 to 100 (0)

Upmix Front Width Specifies the amount of narrowing or widening to 
perform on the front channels

-100 to 100 (0)

Upmix Surround Width Specifies the wideness of the surround channels -100 to 100 (0)

Upmix LFE Cutoff Specifies the cutoff frequency for the generated LFE 
channel

 0 Hz

 60 Hz

 80 Hz

 100 Hz

 120 Hz

 140 Hz 
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Parameter Name Function Options

Downmix L/R Encoding 
Mode

Specifies the encoding mode for the left and right 
channels

 Phantom Center

 Hard Center 

Downmix LFE Cutoff Specifies the cutoff frequency of the input LFE 
channel

 0 Hz

 60 Hz

 80 Hz

 100 Hz

 120 Hz

 140 Hz 

Multi Final Limiter 
Ceiling

Specifies the threshold where final limiting on the 
surround output occurs

-20 dBFS to 0 dBFS

Stereo Final Limiter 
Ceiling

Specifies the threshold where final limiting on the 
auxiliary stereo output occurs

-20 dBFS to 0 dBFS 

Table 4-6  DTS Neural Surround Audio MultiMerge Parameters (Continued)

Table 4-7  Input Selection Mode Option Descriptions 

Option Notes

Mix  This option sums the Aux input to the L/R of the 5.1 input.

 The AES1, AES2, AES3 inputs are 5.1 (L/R, C/LFE, Ls/Rs) in.

 The AES4 input is 2.0 in (L/R) in.

 The AES1 output is a sum of AES 1 and AES 4 (AES1L + AES4L, AES1R + AES4R).

 The AES2 output is C/LFE.

 The AES3 output is LsRs.

Multi  This option only sources audio from the 5.1 input.

 Inputs are AES1 (L/R), AES2 (C/LFE), AES3 (Ls/Rs).

 Outputs are AES1 (L/R), AES2 (C/LFE), AES3 (Ls/Rs).

 AES4 is not used

Stereo  Audio is sourced from only the L/R pair, while simultaneously muting the C/LFE and Ls/Rs pairs 
of the 5.1 input (used in situations where there is information on the other inputs that you 
would want to ignore).

 Input is AES1 (L/R)

 Output is AES1 (L/R)

 AES2, AES3, AES4 are not used

Aux  This option only sources audio from the Aux input.

 Input is AES4 (L/R).

 Output is AES4 (L/R).

 AES1, AES2, AES3 is not used

Multi Detect  If audio is present on the 5.1 input, the Aux input is overridden.

 Inputs are 2.0 on AES1 (L/R) or 5.1 on AES1 (L/R), AES2 (C/LFE), AES3 (Ls/Rs) or 2.0 on AES4 (L/
R).

 Outputs are 5.1 on AES1 (L/R), AES2 (C/LFE), AES3 (Ls/Rs) and 2.0 on AES4 (L/R)
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Stereo Detect If audio is present on the L/R pair of the 5.1 input, the Aux input is overridden. Information on 
the C/LFE and Ls/Rs pairs of the 5.1 input is ignored.

Aux Detect  If audio is present on the Aux input, the 5.1 input is overridden.

 This is an EAS application mode.

 Inputs are 5.1 on AES1 (L/R), AES2 (C/LFE), AES3 (Ls/Rs), and EAS input on AES4 
(L/R).

 Output is 5.1 on AES1 (L/R), AES2 (C/LFE), AES3 (Ls/Rs).

 When EAS appears on AES4 input, the output becomes EAS output on AES1 (L/R).

Multi Aux 
Stereo

 If audio is present on the 5.1 input, the Aux input is overridden. 

 If only L/R is present on the 5.1 input and audio is present on the Aux, the L/R is overridden. 

 If there is no audio present on C/LFE, Ls/Rs, or Aux inputs, source from L/R.

 If 5.1 is present, take 5.1.

 If there is no 5.1 or stereo available on either L/R or AUX, take AUX.

 If stereo is only available on L/R, take L/R.

Table 4-7  Input Selection Mode Option Descriptions (Continued)

Option Notes

MultiMerge 
Input

Scenario 1 
(5.1)

Scenario 2 
(Lt/Rt) Scenario 3

AES 1 L/R Yes Yes (foreign 
language)

Yes (foreign 
language)

AES 2 C/LFE Yes No No

AES 3 LS/RS Yes No No

AES 4 Aux No Yes (desired 
language)

No
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DTS Neural Loudness Control

Overview
The X50 offers two program channels of DTS Neural Loudness Control—a loudness leveling 
device that uses advanced psycho-acoustic and signal processing techniques to accurately 
detect and regulate the perceived loudness of stereo and 5.1 sources. Using this feature, 
you can regulate audio without creating the perception of being “squashed” or 
compressed. 

One of the important aspects of loudness control is frequency compensation, also known as 
loudness shaping. Loudness studies dating back to Fletcher/Munson in the 1930s found 
that the human ear is more sensitive to different frequencies at different loudness levels. 
The Loudness Shaping (Frequency Compensation) parameter preserves the same 
perceptual frequency balance as the input signal, while correcting the loudness to match a 
desired Target Level. 

For example, with Loudness Shaping enabled at a medium level, signals that fall below 
the Target Level setting have more gain added to middle frequencies than higher or lower 
frequencies. This preserves the original spectral balance. Conversely, signals that fall above 
the Target Level setting will have middle frequencies attenuated more than higher or 
lower frequencies. Because the Loudness Shaping parameter applies less gain to high and 
low frequencies, high or low frequency noise does not become over-emphasized.

Figure 4-6.  DTS Neural Loudness Control Block Diagram
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Presets
The Loudness Control feature uses four different presets (Ultra-Light, Light, Medium, and 
Aggressive). Table 4-8 lists the values that each of these presets represents.

Table 4-8  DTS Neural Loudness Control Preset Settings

Parameter Name Ultra Light Light Medium Aggressive

Loudness Measurement Type LEQ 1770 LEQ 1770 LEQ 1770 LEQ 1770

Target Loudness Level (dBeq) -- -- -- --

LC Ratio 0.80 0.95 0.98 1.0

Upper Loudness Threshold (dB) 0.0 0.0 0.0 0.0

Lower Loudness Threshold (dB) 0.0 0.0 0.0 0.0

Freeze Window (dB) 5.0 4.0 2.0 1.0

Quiet Threshold (dBEq) -55.0 -55.0 -55.0 -55.0

Attack 80.0 50.0 50.0 50.0

Release 300.0 220.0 150.0 100.0

Compressor Threshold (dB) 5.0 5.0 5.0 5.0

Compressor Ratio 0.5 0.5 0.5 0.5

Loudness Shaping 0.0 0.0 0.0 0.0

Final Limiter Ceiling (dBFS) 0.0 0.0 0.0 0.0

Loudness Control Function 0 0 0 0

Run Final Limiters Enable Enable Enable Enable

Meter Algorithms Enable Enable Enable Enable

Table 4-9  Recommended Presets, by Country

Country Recommendation Target 
Loudness

Allowable 
Variance Suggested Preset

Australia and 
New Zealand)

OP-59 -24 Unknown at this time Dependent on 
Allowable Variance

Canada ATSC A-85 -24 +/- 2 Ultra Light, Light

Europe EBU.R.128 -23 +/- 1 Medium, Aggressive

Japan ARIB TR B-32 -24 +/- 1 Medium, Aggressive

US ATSC A-85 -24 +/- 2 Ultra Light, Light

Belgium (French) EBU.R.128 -23 +/- 1 Medium, Aggressive
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Loudness Control Mapping
Each Loudness Control menu within each AAP block (DTS Neural Loudness Ctrl 1/2/3/4) 
corresponds to a loudness control function of a given AAP loudness control mode. Each 
mode containing LC may have one or more loudness control sections with related control 
parameter menus.

Table 4-10  Loudness Control Mapping 

Mode Loudness Control Functions Related Control Parameter Menu

Loudness Control 2.0 One loudness control function on 
the 2.0 channels 

DTS Neural Loudness Ctrl 1 

Loudness Control 5.1 One loudness control function on 
the 5.1 channels

DTS Neural Loudness Ctrl 1

Loudness Control 4 x 2.0 One loudness control function on 
each of the four 2.0 pairs

 Ch 1 & 2: DTS Neural Loudness Ctrl 1 
 Ch 3 & 4: DTS Neural Loudness Ctrl 2
 Ch 5 & 6: DTS Neural Loudness Ctrl 3
 Ch 7 & 8: DTS Neural Loudness Ctrl 4

MultiMerge, Loudness Control Two loudness control functions  One for the 5.1 output (Ch 1-6): 
DTS Neural Loudness Ctrl 1 

 One for the 2.0 output (Ch 7 & 8): 
DTS Neural Loudness Ctrl 2 

Upmix, Loudness Control One loudness control function for 
the 2.0 inputs to Upmix 

DTS Neural Loudness Ctrl 1 

Downmix, Loudness Control One loudness control function for 
the 2.0 outputs from Downmix 

DTS Neural Loudness Ctrl 1

Loudness Control 5.1 + 2.0 Two loudness control functions  One for the 5.1 outputs (Ch 1-6): 
DTS Neural Loudness Ctrl 1

 One for the 2.0 outputs (Ch 7 & 8): 
DTS Neural Loudness Ctrl 2 

Loudness Control 2x1.0 Two loudness control functions  One for the first output (Ch 1):
DTS Neural Loudness Ctrl 1

 One for the second output (Ch 2): 
DTS Neural Loudness Ctrl 2 

Loudness Control + DD Encode 
5.1

One loudness control for the 5.1 
inputs to the DD encoder 

DTS Neural Loudness Ctrl 1

Loudness Control + DE Encode 
5.1+2.0

Two loudness control functions  One for the 5.1 inputs to the DE 
encoder (Ch 1-6): 
DTS Neural Loudness Ctrl 1

 One for the 2.0 inputs to the DE 
encoder (Ch 7 & 8): 
DTS Neural Loudness Ctrl 2 

Loudness Control + DE Encode 
4x2.0 

Four loudness control functions  One for Ch 1 & 2 input to the DE 
encoder: DTS Neural Loudness Ctrl 1 

 One for Ch 3 & 4 input to the DE 
encoder: DTS Neural Loudness Ctrl 2

 One for Ch 5 & 6 input to the DE 
encoder: DTS Neural Loudness Ctrl 3 

 One for Ch 7 & 8 input to the DE 
encoder: DTS Neural Loudness Ctrl 4 
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Loudness Control Parameters

Table 4-11  DTS Neural Audio Loudness Control Parameters

Parameter Name Function Options

Loudness Control Function Enables the Loudness Control feature  Enable
 Disable 

Loudness Control Status Indicates the state of the AAP mode  Uninitialized
 Running
 Not Running (bypassed)
 Not Running 

Target Loudness Level Specifies the loudness level that will be targeted -40 dBEq to 0 dBEq 
(-27 dBEq)

LC Ratio Controls the amount of gain or attenuation that is 
applied when loudness differences are measured 

0% to 100% (90%)

Upper Threshold Specifies the highest measured loudness of the 
input that will be permitted before attenuation is 
applied

0 dB to 20 dB

Lower Threshold Specifies the lowest measured loudness of the input 
that will be permitted before gain is applied

-20 dB to 0 dB

Freeze Window Specifies the size of a window in which small 
loudness differences are allowed without the need 
to change gain or attenuation

0.0 dB to 10.0 dB (1.0 dB)

Quiet Threshold Controls the noise floor level -80 dBEq to -20 dBEq 
(-50 dBEq)

Attack Time Controls how quickly the processing will respond to 
sharp increases in loudness

5 ms to 150 ms (20 ms)

Release Time Controls how quickly the processing will respond to 
sharp decreases in loudness

20 ms to 500 ms (120 ms)

Compressor Threshold Controls the amount of attenuation applied when 
short-term peaks exceed the compressor threshold

0 dB to 16 dB (5 dB)

Compressor Ratio Controls the amount of attenuation applied when 
short-term peaks exceed the compressor threshold

0% to 100% (40%)

Loudness Shaping Specifies the amount of loudness shaping desired 0.0 to 1.0 (0.5)

Final Limiter Ceiling Specifies the threshold above which final limiting 
will be applied

-20 dBFS to 0 dBFS (0 dBFS)

Metering Activates the real-time meter.  Off
 On

Current Input Loudness 
[RO]

Reports the smoothed input loudness measurement -60 dBEq to 20 dBEq 
(0 dBEq)

Current Input Peak [RO] Reports the input peak measurement -60 dBFS to 20 dBFS (0 dBFS)

Current Output Loudness 
[RO] 

Reports the smoothed output loudness 
measurement

-60 dBEq to 20 dBEq 
(0 dBEq)

Current Output Peak [RO] Reports the output peak measurement -60 dBFS to 20 dBFS (0 dBFS)

Current Correction [RO] Reports the amount of correction being applied -60 dB to 60 dB (0 dB)

Current Compression [RO] Reports the amount of compression being applied -60 dB to 60 dB (0 dB)
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5 Specifications
Video Input

3G/HD/SD-SDI 

Table 5-1  3G/HD/SD-SDI Input Video Specifications

Item Specification

Number of inputs 2

Standard  3G: SMPTE 424M (2.97, 2.97/1.001 Gb/s), SMPTE 425 Level A, Level B-DL 
(YCrCb, 4:2:2, 10-bit with 16 channels of embedded audio)

 HD: SMPTE 292M (1.485, 1.485/1.001 Gb/s)

 SD: SMPTE 259M-C (270 Mb/s, 525/625 component video)

Connector BNC (IEC169-8)

Impedance 75 

Return loss  >10 dB, typical, from 5 MHz to 2970 MHz

 >15 dB, typical, from 5 MHz to 1485 MHz

 >20 dB, typical, from 5 MHz to 270 MHz

Equalization Hardware Revision 1*

 3G: Adaptive cable equalization for up to 164 ft (50 m), typical, of Belden 
1694A co-axial cable

 HD: Adaptive cable equalization for up to 492 ft (150 m) typical, of Belden 
1694A co-axial cable

 SD: >23 dB Belden 8281 co-axial cable

Hardware Revision 2*

 3G: Adaptive cable equalization for up to 393 ft (120 m), typical, of Belden 
1694A co-axial cable

 HD: Adaptive cable equalization for up to 656 ft (200 m) typical, of Belden 
1694A co-axial cable

 SD: >23 dB Belden 8281 co-axial cable

* See System Setup > Version > Hardware Revision to obtain the information 
about your model
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Fiber

Table 5-2  Fiber Input Specifications 

Item Minimum Typical Maximum Note

OP+SFP+TR13P Single-Mode Transceiver Module

Number of LC 
connector inputs

- - 1

Input wavelength 1260 nm - 1620 nm

Optical power monitor 
accuracy

-2 dB 0 2 dB

Sensitivity at 270 Mb/s
(SMPTE 259M)

- -22 dBm -20 dBm Pathological

Sensitivity at 1.5 Gb/s 
(SMPTE 292M)

- -22 dBm -19 dBm Pathological

Sensitivity at 3 Gb/s 
(SMPTE 424M)

- -19 dBm -18 dBm Pathological

Overload 0 dBm - - BER = 1E-12 against SDI matrix check field 
signals for video applications. BER = 1E-12 
against PRBS 223-1 for datacom applications.

OP+SFP+TR27P to OP+SFP+TR61P Single-Mode Transceiver Modules

Number of LC 
connector inputs

- - 1

Input wavelengths 
(18 Wavelengths from 
1270 nm to 1610 nm, 
each step 20 nm)

1264.5 1270 1277.5

1284.5 1290 1297.5

1304.5 1310 1317.5

1324.5 1330 1337.5

1344.5 1350 1357.5

1364.5 1370 1377.5

1384.5 1390 1397.5

1404.5 1410 1417.5

1424.5 1430 1437.5

1444.5 1450 1457.5

1464.5 1470 1477.5

1484.5 1490 1497.5

1504.5 1510 1517.5

1524.5 1530 1537.5

1544.5 1550 1557.5

1564.5 1570 1577.5

1584.5 1590 1597.5

1604.5 1610 1617.5



X50
Installation and Operation Manual

89
Composite Video

S-Video

Receiver sensitivity at 
270 Mb/s 
(SMPTE 259M)

- -20 dBm -- Pathological;
PRBS 223-1, BER=1E-12 sensitivity:-21 dBm

Receiver sensitivity at 
1.5 Gb/s 
(SMPTE 292M)

0 -- -20 dBm Pathological

-21 dBm PRBS 223-1, BER=1E-12

Receiver sensitivity at 3 
Gb/s 
(SMPTE 424M)

0 -- -18 dBm Pathological

-20 dBm PRBS 223-1, BER=1E-12

Receiver optical rise 
time/fall time
(20% to 80%, 
unfiltered)

-- -- 1.5 ns SMPTE 259M

-- -- 800 ps SMPTE 344M

-- -- 270 ps SMPTE 292M

-- -- 135 ps SMPTE 424M

Table 5-2  Fiber Input Specifications (Continued)

Item Minimum Typical Maximum Note

Table 5-3  Composite Video Input Specifications 

Item Specification

Standard  NTSC (SMPTE 170M)

 PAL-B (ITU 624-2)

 PAL-M

Connector BNC (IEC 169-8)

Processing 12-bit adaptive 3D comb filter color decoder

Input level 1.0 V pk-to-pk

Impedance 75 

Return loss >40 dB, 0.1 MHz to 6 MHz

Common mode range 5.0 V

CMRR 60 dB @ 50/60 Hz, 5 V pk-to-pk

Table 5-4  S-Video Input Specifications

Item Specification

Standard  NTSC

 PAL-B

 PAL-M

Connector 4-pin DIN
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Component Video

Genlock

Table 5-5  Component Video Input Specifications

Item Specification

Format Betacam/SMPTE

Connector BNC (IEC 169-8)

Input level 1.0 V pk-to-pk

Impedance 75 

Return loss >40 dB, 1 kHz to 6 MHz

Table 5-6  Genlock Input Specifications

Item Specification

Connector BNC (IEC169-8)

Impedance 75 

Return loss  >40 dB (typical) to 6 MHz

 >35 dB (typical) to 30 MHz

Common mode range 5.5 V pk-to-pk

CMRR 60 dB @ 60Hz, 5 V pk-to-pk

Input level  1 V pk-to-pk, -5.0 dB to +6.0 dB for NTSC/PAL-B

 ±300 mV, -3.5 dB to +6.0 dB for Tri-Level Sync:

 1080i: 59.94/50

 1080p: 29.97/25

Signal type  NTSC/PAL-B Analog Composite

 ±300 mV Tri-Level Sync

Standard  SMPTE 170M (NTSC)

 ITU-R BT.470-6 (PAL-B)

 SMPTE 274M (1080i, 1080p)



X50
Installation and Operation Manual

91
Video Output

3G/HD/SD-SDI

Table 5-7  3G/HD/SD-SDI Output Video Specifications

Item Specification

Number of outputs 2

Standard  3G: SMPTE 424M (2.97, 2.97/1.001 Gb/s), SMPTE 425 
Level A, Level B-DL (YCrCb, 4:2:2, 10-bit with 16 channels 
of embedded audio)

 HD: SMPTE 292M (1.485, 1.485/1.001 Gb/s)

 SD: SMPTE 259M-C (270 Mb/s, 525/625 component video)

Connector BNC (IEC169-8)

Impedance 75 

Return loss  >10 dB, typical, from 5 MHz to 2970 MHz

 >15 dB, typical, from 5 MHz to 1485 MHz

 >20 dB, typical, from 5 MHz to 270 MHz

Signal level 800 mV ± 10%

DC offset 0.0V ± 0.5 V

Rise and Fall Time  3G: <135 ps (20% to 80%)

 HD: <270 ps (20% to 80%)

 SD: 400 - 1500 ps (20% to 80%)

Overshoot < 10% of amplitude (all outputs terminated)

Jitter  Timing jitter:

 3G: <2 UI peak to peak

 HD: <1 UI peak to peak

 SD: <0.2 UI peak to peak

 Alignment jitter:

 3G: <0.3 UI peak to peak

 HD: <0.2 UI peak to peak

 SD: <0.2 UI peak to peak
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Fiber

Table 5-8  Fiber Output Specifications

Item Minimum Typical Maximum Note

OP+SFP+TR13P Single-Mode Transceiver Module

Number of LC connector 
outputs

- - 1

Standards  3G: SMPTE 424M

 HD: SMPTE 292M

 SD: SMPTE 259M

Peak wavelength 1280 nm 1310 nm 1340 nm Measured at 25°C

Spectrum width (RMS) - 1.5 nm 3 nm

Average output power -7 dBm - 0 dBm

Optical rise/fall time (3G 
HD-SDI)

- 105/120 ps 165/180 ps 20% to 80%, are measured 
following a fourth-order 
Bessel-Thompson filter with a 
bandwidth of 0.75 x clock 
frequency corresponding to the 
serial data rate.

Extinction ratio 5dB 7 dB -

Jitter - <110 ps 180 ps SD-SDI Pathological

- <60 ps 100 ps 1.5 G SDI Pathological

- <45 ps 70 ps 3G HD-SDI Pathological

Laser safety level Class 1

OP+SFP+TR27P to OP+SFP+TR61P Single-Mode Transceiver Modules

Number of LC connector 
outputs

- - 1

Transmitter output power 0 dBm -- 4 dBm Output power is power 
coupled into a 9/125 mm single 
mode fiber.

Optical link budget 20 dB -- --

Transmitter optical rise 
time/fall time (20% to 
80%, unfiltered)

-- -- 1.5 ns SMPTE 259M

-- -- 800 ps SMPTE 344M

-- -- 270 ps SMPTE 292M

-- -- 135 ps SMPTE 424M

Spectrum width (RMS) - -- 1 nm -20 dB width 

Extinction ratio 5 dB 7.5 dB --
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HDMI

S-Video

Composite Video

Table 5-9  HDMI Output Specifications

Item Specification

Number of outputs 1

Standards  525
 625
 1080i/59.94
 1080i/50

 1080p/23.98
 720p/59.94
 720p/50

Connector HDMI

Compliance HDMI 1.3

Table 5-10  S-Video Output Specifications

Item Specification

Standard  NTSC
 PAL-B
 PAL-M

Connector 4-pin DIN

Table 5-11  Composite Video Output Specifications

Item Specification

Standard  NTSC
 PAL-B
 PAL-M

Connector BNC (IEC 169-8)

Resolution 12 bits

Impedance 75 

Return Loss >40 dB, 0.1 MHz to 6 MHz

Frequency response -1.6 dB at 6 MHz

DC offset <0.5 mV

Differential gain <0.5%

Differential phase ≤1.2° pk-to-pk

Y/C gain <1°, typical

Y/C delay  <10 ns (NTSC)
 <23.1 ns (PAL)

Transient response <0.5% K Factor

SNR 63 dB, typical, luma ramp
  



Chapter 5
Specifications

94

  
Component Video

Audio Input

AES/DARS

Table 5-12  Component Video Output Specifications

Item Specification

Format Betacam/SMPTE

Connector BNC (IEC 169-8)

Resolution 12 bits 

Impedance 75

Return loss >40 dB, 1 kHz to 6 MHz

Frequency Response  -0.5 dB to 5.5 MHz (Y)

 -3.27 to 3.0 MHz (Pb/Pr)

DC offset <0.0 ±5 mV

Relative delay <±10 ns

SNR 63 dB, typical, luma ramp

Table 5-13  AES/DARS Input Specifications

Item Unbalanced Specification

Number of inputs 4 x AES, 1 x DARS

Standard AES3, SMPTE 276M

Type Unbalanced, AC coupled

Connector 1.0/2.3 DIN

Sensitivity 100 mV

Impedance 75

Return loss >25 dB, 0.1 MHz to 6 MHz

Input sampling rate 32 kHz to 108 kHz

Bits 16, 20, or 24

Channel status 
and user bit

Maintained, but professional mode, 48 kHz. See page 102 for 
details.
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Analog

Audio Output

AES

Table 5-14  Analog Audio Input Specifications

Item Specification

Number of inputs 8 mono channels

Type Balanced

Connector DB-25, Tascam-style cable snake for balanced 8-channel audio

Input audio level 28 dBu to 12 dBu for 0 dBFs (adjustable in 0.5 dB increments)

Input Impedance High-Impedance or 600, jumper selectable

CMRR >80 dB @ 60 Hz, typical

Table 5-15  AES Output Specifications

Item Unbalanced Specifications

Number of outputs 4

Standard AES3, SMPTE 276M

Type Unbalanced, AC coupled

Connector 1.0/2.3 DIN

Signal amplitude 1.0 V pk-to-pk ±10% 

Impedance 75

Return loss >25 dB, 0.1 MHz to 6 MHz

Jitter <20 ns

DC offset 0.0 ±50 mV

Rise/fall time 30 ns to 44 ns (10% to 90%)

Output sampling rate 48 kHz

Bits 24, 20 or 16

Channel status 
and user bit

Maintained, but professional mode, 48 kHz. See Audio 
Bit Manipulation on page 101 for full details.
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Analog 

Conversion Capabilities
Please see the separate X50 Conversion Table for this information, located on the Imagine 
Communications website.

Communications

GPI In/Out

Table 5-16  Analog Audio Output Specifications

Item Specification

Number of inputs 8 mono channels

Type Balanced

Connector DB-25, Tascam-style cable snake for balanced 8-channel 
audio

Output audio level 28 dBu to 16 dBu (adjustable in 2 dB increments)

Output Impedance 66

Frequency response 0.15 dB, 20 Hz to 20 kHz

THD 80 dB, 20 Hz to 20 kHz

SNR >100 dB typical

Crosstalk >90 dB, 20 Hz to 20 kHz, typical

Linearity <1.0 dB (-80 dBu to + 20 dBu), typical

Table 5-17  GPI In/Out Specifications

Item Specification

Connector DB-9

Inputs  Number: 4

 Internally pulled HIGH (+5V)

 External: Contact closure to ground to trigger

Outputs  Number: 4

 TTL-compatible

 75

 Sink and source 64 mA (low), -32 mA (high)
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RS-422

LAN 

Temperature
The X50 requires an ambient temperature of 41º to 95º F (5º to 35º C) with a relative 
humidity of 10-90% (non condensing).

Power Consumption
The X50 operates at 100-240 VAC, 47-63 Hz, 75 W.

Dimensions and Weight

Table 5-18  RS-422 Specifications

Item Specification

Standard RS-422

Connector DB-9

Table 5-19  LAN Specifications

Item Specification

Connector RJ-45

Type 10/100 Ethernet

Table 5-20  Dimension and Weight Specifications

Item Specification

Weight 8.45 lb. (3.83 kg), excluding rack and cable supports 

Height 1.72 in. (4.37 cm)

Width 17.47 in. (44.4 cm); 17.60 in. (44.7 cm) with rear supports 

Depth 21.25 in. (54.0 cm) 
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A Laser Safety Guidelines
Laser Safety

WARNING

Use of controls, adjustments, and procedures other than those specified in this 
document may result in hazardous laser radiation exposure. 

Optical fiber telecommunication systems use semiconductor laser transmitters that emit 
infrared light that is normally not visible to the human eye. Although a conventional laser 
produces a small beam of light, the power density is very high, and it can cause damage to 
your eyes.

If a beam of laser light enters the eye, the eye magnifies and focuses the energy on the 
retina. The energy that reaches the retina can be as much as 100,000 times more than at the 
cornea and, as a result, it can burn the retina. 

Laser transmission products are classified in four major groups (Class 1, 2, 3, and 4), 
according to their emissions and potential for causing injury. Fiber optic transmitter modules 
in this series are designated Class 1.

Precautions for Enclosed Systems
In its normal operating mode, an optical fiber communication system is totally enclosed and 
presents no risk of eye injury. However, if the fiber optic cables that interconnect various 
components of an optical fiber disconnect or break, you may be exposed to laser emissions. 
Also, technicians may be exposed to laser emissions during installation and servicing. 

Unlike some other laser designs, semiconductor lasers have a highly divergent beam that 
decreases rapidly with distance. The greater the distance, the less energy will enter the eye, 
and the less potential risk for eye injury. 

WARNING

Eye damage may occur if an optical instrument such as a microscope, magnifying 
glass, or eye loupe is used to stare at the energized fiber end. 

Under normal operating conditions, optical fiber telecommunication systems are completely 
enclosed; nonetheless, observe the following precautions: 
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1 Do not stare into optical connectors or broken fibers. 

2 Ensure technicians have satisfactorily completed an approved training course before 
performing installation or maintenance.

3 Ensure there are appropriate warning labels near the optical ports of the modules.

Precautions for Unenclosed Systems
During service, maintenance, or restoration, an optical fiber telecommunication system is 
considered unenclosed. Under these conditions, follow these practices: 

CAUTION

Only authorized, trained personnel shall be permitted to do service, maintenance, 
and restoration.

1 Avoid exposing the eye to emissions from unterminated, energized optical connectors at 
close distances.

2 Ensure that only authorized, trained personnel use optical test equipment during 
installation or servicing. 

3 Turn off all laser sources before scanning a fiber with an optical test set.

4 Keep all unauthorized personnel away from the immediate area of the optical fiber systems 
during installation and service. 

For guidance on the safe use of optical fiber communication systems in the workplace, 
consult ANSI Z136.2, American National Standard for Safe Use of Lasers in the U.S. or 
outside the U.S., IEC-60825, Part 2.

Label The label shown is applicable to Class 1 laser products.

Figure A-1  Label for Class 1 Laser Products

CLASS 1
LASER PRODUCT
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B Audio Bit Manipulation 
Overview This appendix contains information on the manipulation of bits that occur when using X50 
modules.

RX Key: N = not recognized, Y = recognized, S = recognized and stored or passed through 
or both

TX Key: N = not transmitted, Y = transmitted
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Channel Status Bits
Table B-1  C-Bit Manipulation 

Byte Bit Function RX TX Remarks

0 0 [0] Consumer use
[1] Professional use

N
Y

N
Y

Set to [1]

0 1 [0] Normal audio mode (linear PCM)
[1] Non-audio (non-PCM)

S
S

Y
Y

Passed unmodified

0 2 to 4 [000] Not indicated
[100] No emphasis
[110] 50/15 µs
[111] CCITT J.17

S
S
S
S

Y
Y
Y
Y

Passed unmodified

0 5 [0] Locked
[1] Unlocked

N
N

Y
N

Set to [0]

0 6 to 7 [00] Not indicated
[01] 48 kHz
[10] 44.1 kHz
[11] 32 kHz

Y
Y
Y
Y

N
Y
N
N

Set to [01]

1 0 to 3 [0000] Not indicated
[0001] Two channel
[0010] Mono
[0011] Prim/sec
[0100] Stereo
[0101] to [1111] Undefined

N
N
N
N
N
N

Y
N
N
N
N
N

Set to [0]

1 4 to 7 [0000] Not indicated
[0001] 192 bit block
[0010] AES18 (HDLC)
[0011] User defined
[0100] to [1111] Undefined

N
N
N
N
N

Y
Y
Y
Y
Y

Set to [0]

2 0 to 2 [000] Not indicated
[001] Audio data
[010] Co-ordination signal
[011] to [111] Undefined

N
N
N
N

N
Y
N
N

Set to [001] for 24-bit or 20-bit 
output bit width settings; and 
[000] for 16-bit output bit width 
setting

2 3 to 5 [000] Not indicated
[001] Max length - 1
[010] Max length - 2
[011] Max length - 3
[100] Max length - 4
[101] Max length
[110] to [111] Undefined

N
N
N
N
N
N
N

N
N
N
N
N
Y
N

Set to [101] for 24-bit output bit 
width setting; [100] for 20-bit or 
16-bit output bit width settings

2 6 to 7 Reserved N Y Set to [0]

3 0 to 7 Reserved N Y Set to [0]

4 0 to 1 [00] Not a reference 
[01] Grade 1 reference
[10] Grade 2 reference
[11] Undefined

N
N
N
N

Y
N
N
N

Set to [0]

4 2 Reserved N Y Set to [0]
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Validity and User Bits

4 3 to 6 [0000] Not indicated
[1000] 24 kHz
[0100] 96 kHz
[1100] 192 kHz
[1100] 22.05 kHz
[0101] 88.2 kHz
[1101] 176.4 kHz
[1111] User defined

N
N
N
N
N
N
N
N

Y
N
N
N
N
N
N
N

Set to [0000]

4 7 [0] Sample frequency not scaled
[1] Sample frequency scaled by 1/
1.001

N
N

Y
N

Set to [0]

5 0 to 7 Reserved N Y Set to [0]

6 to 9 0 to 7 Alphanumeric channel origin data S Y Passed unmodified

10 to 13 0 to 7 Alphanumeric channel destination 
data

S Y Passed unmodified

14 to 17 0 to 7 Local sample address code S Y Passed unmodified

18 to 21 0 to 7 Time-of-day sample address code S Y Passed unmodified

22 0 to 3 Reserved N Y Set to 0

22 4 Bytes 0 to 5 reliability flag S Y Passed unmodified

22 5 Bytes 6 to 13 reliability flag S Y Passed unmodified

22 6 Bytes 14 to 17 reliability flag S Y Passed unmodified

22 7 Bytes 18 to 21 reliability flag S Y Passed unmodified

23 0 to 7 CRC Y Y Calculated on output

Table B-1  C-Bit Manipulation (Continued)

Byte Bit Function RX TX Remarks

Table B-2  V-Bit and U-Bit Manipulation

Bit Manipulation RX TX Remarks

Validity (V) bit S Y Passed unmodified

User (U) bit S Y Passed unmodified
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Miscellaneous Data

Table B-3  Miscellaneous Data

Item RX Specification TX Specification

Audio sampling frequency 32 to 48 kHz 48 kHz

Audio sampling word 
length

16 to 24 bits 24 bits
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C Servicing 
Overview
User-serviceable replacement parts are available for the following X50 components: 

 X50OPT-ADVAUD audio submodule for Dolby and DTS Neural options

 X50SPR-DISP front panel PCB assembly (includes OLED display, shaft encoder, and circuit 
board) 

 X50SPR-FAN fan module 

 X50SPR-PSU power supply

 X50SPR-SE shaft encoder and knob

 142-100017Q00 nylon shoulder washer

 Rack ears and rear support mounting parts (See page 7 for details, including installation)

There are two types of X50 cover assemblies, depending upon the date of manufacture. 
Each requires a different removal procedure. Table C-1 shows the different servicing 
procedure required in each case.

Table C-1  Servicing Options

Service Requirement

X50 Version
Addition of 
Audio 
Submodule

Failed LCD/
OLED 
Display

Failed Fan
Failed 
Power 
Supply

Failed/
Broken 
Shaft 
Encoder

Preventing 
a Broken 
Shaft 
Encoder

Version 1
(Integrated front/top 
panel, green LCD, large 
shaft encoder hole)

Install new audio 
submodule on 
main board

Install 
refurbished X50

Option 1: Install 
new fan
Option 2: Install 
refurbished X50

Option 1: Install 
new power 
supply
Option 2: Install 
refurbished X50

Option 1: Install 
new shaft 
encoder 
Option 2: Install 
refurbished X50

Install shaft 
shoulder washer, 
(available 
directly from our 
Customer Service 
department) 

Version 2
(separate front panel and 
lid, green LCD, small shaft 
encoder hole)

Install new audio 
submodule on 
main board

Install 
refurbished X50

Install new fan Install new 
power supply

Install new shaft 
encoder

No service 
required

Version 3
(Separate front panel and 
lid, blue OLED, small shaft 
encoder hole)

Install new audio 
submodule on 
main board

Install new front 
panel assembly

Install new fan Install new 
power supply

Option 1: Install 
new shaft 
encoder
Option 2: Install 
new blue OLED 
PCB assembly

No service 
required
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Cover Removal and Replacement

Version 1

The Version 1 unit includes a combined front cover/frame lid. Follow these steps to remove 
and replace the Version 1 front cover and lid:

1 Disconnect both AC power cords.

WARNING: You can receive an electric shock from exposed parts of the power 
supplies. Ensure that you remove AC power from both power supplies before you 
open the cover.

2 Remove 15 screws from the one-piece front panel/lid (12 on the top; 3 on the bottom). 

3 Pull the scrolling knob straight off its shaft and then carefully slide the lid off the unit.

CAUTION! Do not tilt the front cover/lid as you remove it. This may damage circuit 
board components.

4 After you have completed servicing, replace the cover.

Approach the unit with the cover at a 10°angle, slide the front over the encoder shaft, 
and then, with the corner angle past the mounting ear, gently lower the lid and slide it 
into position.

Figure C-1.  Replacing the Cover

5 Gently re-insert the flexible LED tubes.

Use a pin to help re-insert the light tubes back into their slots. (See Figure C-2 on 
page 107.) Do not attempt to adjust the LEDs located on the left side of the control 
panel (these are fixed circuit board LEDs).

10° angle

Position the lip past the 
mounting ear.
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Version 2 and 3

Versions 2 and 3 feature a separate front cover and lid. Follow these steps:

1 Disconnect both AC power cords.

WARNING: You can receive an electric shock from exposed parts of the power 
supplies. Ensure that you remove AC power from both power supplies before you 
open the cover.

2 Remove the 9 screws from the X50 lid.

3 Lift the cover straight up and off the frame.

The power supplies are now accessible for servicing. For other replacement parts, 
continue with the following steps.

4 Remove the 9 screws from the top and bottom of the dark grey front cover (do not remove 
screws from the side mounting ears).

5 Pull the scrolling knob straight off its shaft and then carefully slide the front cover off the 
unit.

CAUTION! Do not tilt the frame as you remove the cover. Damage may occur.

6 After you have completed servicing the unit, reverse steps 1 to 5.

As you replace the front cover, take care to gently re-insert the flexible LED tubes.

Use a pin to help re-insert the light tubes back into their slots. Do not attempt to adjust 
the LEDs located on the left side of the control panel (these are fixed circuit board 
LEDs).

Figure C-2.  Re-Aligning Flexible Light Tubes
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Installation of Advanced Audio Processing Submodule
To use advanced audio processing in the X50, you must install an X50OPT-ADVAUD audio 
submodule and purchase the appropriate software license keys. The audio submodule kit 
includes the submodule board, two short screws, one longer screw, and one standoff. The 
procedure for both versions of the X50 is the same.

Follow these steps to install the audio submodule:

1 Remove the X50 cover, as described on page 106, ensuring both power supplies are 
disconnected.

2 Remove the main board mounting screw located behind the left power supply, as shown in 
Figure C-3.

Figure C-3.  Removal of Mounting Screw

3 Position and align the audio submodule over the standoffs, then gently press it into place.

The audio submodule will lock into place as it is inserted into its connector.

Figure C-4.  Aligning with Standoffs

Remove this screw

Align holes 
with standoffs
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4 Insert a short screw into one of the standoffs, but do not tighten.

5 Remove the loose standoff supplied in the package and slide it under the audio submodule, 
above the hole where you removed the main board screw.

Note: This standoff is not threaded.

Figure C-5.  Inserting Third Standoff

6 Insert the longer screw into this hole and lightly tighten.

7 Insert and tighten the final screw into the remaining standoff.

8 Lightly tighten the other two screws.

Figure C-6.  Three Mounting Screws

9 Replace the cover as described earlier, and then re-attach the two power cords.

Unthreaded standoff

New 
standoff

Existing 
standoffs

2

13
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LCD or OLED Display Replacement

The LCD displays found on Version 1 and 2 units are not serviceable. All version 3 models 
are serviceable, using a blue OLED. For identification: measured diagonally, the Version 1 
and Version 2 LCD screens are larger, at 3.5 inches (9.1 cm); Version 3 OLED screens are 3 
inches diagonally (7.5 cm). 

Figure C-7.  Comparison of LCD and OLED Screens

Follow these steps to remove and replace an LCD or OLED display:

1 Remove the X50 cover, as described on page 106, ensuring both power supplies are 
disconnected

2 Remove the fan power supply connectors located behind the circuit board.

Figure C-8.  Removing Connectors Behind Circuit Board

Version 1 and 2 LCD

Version 3 OLED

3.5 in (9.1 cm)

3.0 in (7.5 cm)

Gently unplug the 
connectors



X50
Installation and Operation Manual

111
3 Remove the six circuit board mounting screws (Figure C-9).

Figure C-9  Removal of the Mounting Screws

4 Gently pull the circuit board away from the face of the X50, and discard.

5 Align the new circuit board assembly, and gently press it into place, taking care not to bend 
the pins on the left side.

6 Install the six mounting screws supplied, and then re-attach the four fan power supply 
connectors 

7 Replace the cover as described earlier, and then re-attach the two power cords.

1

4

32

65
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Fan Module Replacement

The front fan modules are individually mounted and connected. An additional fan is located 
next to the right power supply.

Follow these steps to remove and replace a fan:

1 Remove the X50 cover, as described on page 106, ensuring both power supplies are 
disconnected

2 Snip and remove the plastic ties wraps holding the fan wires.

Figure C-10.  Fan Wires

3 Carefully unplug the power connector for the failed fan.

4 Remove the two mounting screws for the failed fan, and then remove the fan.

5 Attach the new fan using the screws provided. 

6 Attach the connector to the circuit board.

7 Carefully bundle and re-wrap the wires through the metal holders, ensuring that no wires 
contact the blades of the fans.

8 Replace the cover as described earlier, and then re-attach the two power cords.

Snip and remove these 
tie wraps

Front fan 
connectors

Power supply 
fan connector
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Power Supply Replacement
Follow these steps to remove and replace a power supply:

1 Remove the X50 cover, as described on page 106 or page 107,ensuring both power 
supplies are disconnected.

2 Remove the input and output conductors of the failed power supply by pulling the 
connector and pressing the clip down.

Figure C-11.  Power Supply Removal

Figure C-12.  Power Supply Connector

3 Remove the four power supply mounting screws, and the power supply unit.

4 Install the new power supply using the screws provided, and re-attach the connectors.

5 Replace the cover as described earlier, and then re-attach the two power cords.

Output 
connector

Input connector

Input 
connector

Output 
connector

1 2

Press this clip down when 
removing connector
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Shaft Encoder Replacement
There are two possible replacement parts for a broken shaft encoder: a simple shaft 
encoder (X50SPR-SE) that must be soldered to the front circuit board, or a complete circuit 
board unit (X50SPR-DISP).

To replace a complete circuit board unit because of a broken shaft encoder, see LCD or 
OLED Display Replacement on page 110. To replace a broken shaft encoder separately, 
follow these steps:

1 Disconnect both power cords and remove the cover as described on page 106.

1 Remove the four electrical connectors located behind the circuit board.

Figure C-13.  Removing Connectors Behind Circuit Board

2 Remove the six circuit board mounting screws (Figure C-14).

Figure C-14  Mounting Screws for Front Display Board

3 Gently pull the circuit board away from the face of the X50, taking care not to bend the 
memory board conductors on the left side.

Gently unplug the 
connectors

1

4

32

65
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4 From the back side of the circuit board, de-solder the two mounting hole pegs and the five 
through-hole pegs, using a solder sucker and wick (Figure C-15).

Figure C-15  De-soldering Encoder Pegs

5 From the front of the board, remove any remaining solder.

CAUTION! The traces on the board are fragile and may break if the connections are 
not totally clear. Ensure all solder is gone before you remove the shaft encoder 
from the board.

6 Remove the damaged shaft encoder.

Figure C-16  Shaft Encoder Removed

Through-hole pegs (3)

Through-hole pegs (2)

Mounting 
pegs (2)
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7 Insert the new replacement shaft encoder from the front.

Figure C-17  Inserting New Shaft Encoder

8 Solder the connections to the back of the circuit board, ensuring the shaft encoder is flush 
with the circuit board.

Figure C-18  New Shaft Encoder Installed
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9 Gently press the circuit board back into place, taking care not to bend the pins on the left 
side.

10 Install the six mounting screws supplied, and then re-attach the fan electrical connectors. 

11 Replace the cover as described earlier, and then re-attach the two power cords.

Preventing a Broken Shaft Encoder
Version 2 units contain a nylon shoulder washer that effectively reduces the chance of 
physical damage to the shaft encoder. Version 1 units can be retrofitted, using part number 
142-100017Q00. To install this washer on a Version 1 X50 unit, follow these steps:

1 Remove the knob from its shaft by pulling it straight out.

2 Slide the shoulder washer over the shaft encoder as shown.

You may need to rotate the washer as you insert it into the hole.

Figure C-19.  Installation of Shoulder Washer

3 Replace the knob. 

Slide washer 
into hole
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Changing Jumper Settings
The analog audio input on the X50 can be set to either 600 or Hi-Z impedance (see 
Figure C-20 on page 118). There are eight jumpers for this purpose, located near the rear 
of the main board inside the X50. (The default setting is Hi-Z.) The diagram on the circuit 
board shows how to align the jumpers. 

To access the jumpers, follow these steps:

1 Remove the X50 cover, as described on page 106, ensuring both power supplies are 
disconnected.

2 Set the jumpers as required (Figure C-20).

WARNING: You can receive an electric shock from exposed parts of the power 
supplies. Ensure that you remove AC power from both power supplies before you 
open the cover.

Figure C-20  Analog Audio Input Jumpers J14 to J21
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S-video 89, 93
temperature 97
video input 87–90
video output 91–94
weight and dimensions 97

Subnet Mask 11, 12
Support bracket and relief bar installation 7–10
Support documents x
System requirements 17

T
Teletext system 41
Temperature requirements 7
Third-party control software 19–24

U
Unpacking a product x

User-scripted management 62–64

V
V-bit and U-bit manipulation 103
Video
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Video Index (VI) 31–40
VPID Enable control 42

W
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(WEEE) directive xii
Weight and dimensions specifications 97
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Wide Screen Signalling (WSS) 31–40
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